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ВВЕДЕНИЕ 

Реструктуризация российского лесного хозяйства в свете задач нового лесного 
законодательства, необходимость внедрения положений и методов устойчивого 
лесного хозяйства (sustainable forest management) и учета воздействия глобальных 
изменений природной среды определяют необходимость использования новых 
научных инструментов, получения прогнозных оценок не только “хозяйственной 
производительности” древостоев, но и ряда экологически важных параметров лесных 
экосистем.  

Таким инструментом является динамическое моделирование лесных сообществ 
как системы «растительность-почва», которое в настоящее время успешно развивается 
в Европе и Северной Америке. Применение этих моделей позволяет получить ряд 
экологических характеристик лесных экосистем и лесной территории, которые 
необходимы для оценки успешности устойчивого лесоводства (биомасса 
растительности, параметры лесовозобновительного процесса, изменение 
биологического разнообразия, пулы органического вещества почв и элементов питания, 
фотосинтетическая ассимиляция углерода из атмосферы и эмиссия углекислого газа из 
почвы, баланс углерода в экосистеме). Таблицы и модели хода роста  служат 
инструментом прогноза и анализа различных режимов ведения лесного хозяйства при 
лесохозяйственном планировании (лесные планы и лесохозяйственные регламенты) и 
разработке новых лесохозяйственных приёмов в условиях отсутствия сильных внешних 
воздействиях, таких как изменения климата, загрязнение, лесные пожары и т.д. 

Для анализа динамики лесной экосистемы при сильных воздействиях 
необходимо применение динамических процессных моделей, включающих в себя 
детальное описание основных процессов: роста и продуктивности леса на основе 
представлений физиологии растений и процесса фотосинтеза, процессов 
минерализации и гцмификации органического вещества в почве, обеспечивающих 
устойчивый биологический круговорот элементов почвенного питания растений. Также 
необходим учет водного режима, температурных изменений и пр.   

Многочисленные зарубежные лесные модели, например, финская FinnFor, 
немецкая Foresee [4C], шотландская EFM, американская Century, канадская CBM-CFS 
версии 2 и 3, европейская глобальная BiomBGC, и многие другие требуют серьезной 
калибрации и валидации и, кроме того, их применение связано со значительным 
вложением средств. 

Работы по использованию динамических моделей в российском лесоводстве 
проводились в ограниченном объеме как пилотные проекты. Необходимо расширение 
апробации моделей в качестве нового научно обоснованного инструмента 
лесохозяйственного прогноза, необходимого для принятия решений. Модель EFIMOD, 
которая используется в данной работе, создана на российской концептуальной основе с 
использованием отечественных экспериментальных данных.  
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1. КРАТКИЙ ОБЗОР СОСТОЯНИЯ МОДЕЛИРОВАНИЯ НАЗЕМНЫХ 
ЭКОСИСТЕМ 

Модели лесных экосистем могут значительно расширить возможности 
классического подхода с использованием таблиц хода роста, для предсказания 
динамики леса и почвы в изменяющихся условиях среды и при новых режимах ведения 
лесного хозяйства, а также для лесохозяйственного планирования (лесные планы и 
лесохозяйственные регламенты). До сих пор лесохозяйственное планирование имеет 
краткосрочный характер, тогда как в связи с длительностью цикла лесовыращивания 
практическое лесоводство нуждается в долговременных прогнозах динамики лесов.  

Современные математические модели в экологии можно разбить на три класса. 
Первый – описательные модели: регрессионные и другие эмпирически установленные 
количественные зависимости, не претендующие на раскрытие механизма 
описываемого процесса. Они обычно включаются в виде фрагментов в имитационные 
модели. Второй – модели качественные, которые строятся с целью выявления 
динамического механизма изучаемого процесса, способные воспроизвести 
наблюдаемые динамические эффекты в поведении систем (например, колебательный 
характер в поведении биомассы). Третий класс – имитационные модели конкретных 
экологических и эколого-экономических систем, учитывающие всю имеющуюся 
информацию об объекте. Цель построения таких моделей – детальное прогнозирование 
поведения сложных систем или решение задачи их оптимальной эксплуатации. 

Лесная экосистема является сложной и многоуровневой системой, подходы к ее 
моделированию зависят от задач моделирования, от исследуемого уровня ее 
организации и от наличия экспериментальных данных. Так, основной единицей 
моделирования может быть либо отдельное дерево, либо ярус древостоя или “элемент 
леса”, либо древостой отдельного участка, либо совокупность лесов на ландшафтном 
уровне. Подход к моделированию также определяется и степенью включения основных 
компонентов экосистемы (древесная растительность, живой напочвенный покров, 
почва, атмосфера). Модели отдельного дерева описывают рост дерева с различной 
степенью детализации процессов. В индивидуально-ориентированных моделях 
древостоя рассматривается рост каждого дерева в лесной популяции, принимая во 
внимание конкуренцию или перераспределение ресурсов в пределах “посадки”. В 
моделях посадки не рассматриваются отдельные деревья; они имитируют динамику 
лесных массивов или экосистем с обобщенными характеристиками. 

 Комбинированные модели, объединяя различные типы моделей (модели 
отдельного дерева, индивидуально-ориентированные модели древостоя, модели 
посадки и др.) символизируют переход к новому уровню моделирования. Такие модели 
– наиболее перспективная область развития моделирования леса. Они – средство для 
обобщенного моделирования динамики лесных экосистем в ландшафтных, 
региональных и национальных масштабах. Комбинированные модели имеют вполне 
определенную методологическую основу, при этом моделирование сильно отличается 
от моделирования в масштабах древостоя. Далее должны бы существовать модели 
континентального уровня, но они пока отсутствуют, и последним уровнем 
моделирования являются глобальные модели.  

Модельные системы будут следующим шагом в моделировании леса. Такие 
системы должны разрабатываться в региональном или национальном масштабах, 
объединяя лесоводственные, экологические, технологические, социально-
экономические модели и модели окружающей среды. 

Собственно индивидуально-ориентированное моделирование лесных экосистем 
достаточно успешно развивается за рубежом (Chertov et al., 1999; Комаров, Чертов, 
2007; Чертов, Комаров, 2007). В России также имеются два коллектива, успешно 
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работающие в этом направлении: в Институте физико-химических и биологических 
проблем почвоведения РАН (ИФХБПП РАН, лаборатория экологического 
моделирования, проф. А.С.Комаров, с которым сотрудничает проф. О.Г.Чертов) и в 
Московском государственном университете леса (Вычислительный центр МГУЛ, проф. 
С.И.Чумаченко).  

В подходе Чертова-Комарова (модель лесной экосистемы EFIMOD и лесной 
почвы ROMUL) интегрируется индивидуально-ориентированное, пространственно-
распределенное  и процессное направления в моделировании системы “растение-почва”. 
Здесь почва, наряду с ФАР, выступает регулятором продукционного процесса и 
системным буфером (Chertov et al., 2003; Komarov et al., 2003; Моделирование 
динамики..., 2007).  

Способ простого описания роста дерева, включающего в себя взаимоотношения 
между деревом и почвой, был предложен О.Г.Чертовым (Чертов, 1983; Chertov, 1990). 
При этом способе рассматриваются основные пункты описания дерева с экологической 
точки зрения и его экологические характеристики. Формализация специфических 
видовых характеристик и показателей роста и развития дерева стала возможной на 
основе данных по биологической продуктивности и некоторых эколого-
физиологических характеристик растений.  

EFIMOD представляет собой модель биологического круговорота с расчетом: а) 
роста каждого дерева в насаждении в зависимости от его освещенности и наличия 
доступного азота в почве; б) динамики органического вещества почв с расчетом 
доступного для растений азота и эмиссии углекислого газа из почвы. Модель 
осуществляет прямую оценку значения климата и богатства почв для роста чистых и 
смешанных древостоев, а также для круговорота углерода и азота в лесных 
экосистемах. Задание точных позиций деревьев в древостое и индивидуально-
ориентированный подход дают возможность имитировать различные виды рубок и их 
возможные последствия. Модель динамики органического вещества почвы (ОрВП) 
позволяет учесть последствия лесохозяйственных мероприятий, воздействующих на  
почву, таких как внесение удобрений, разложение порубочных остатков и т.п. 

Использование статистического подхода к описанию сообщества деревьев на 
популяционном уровне не определяет уровень применимости модели EFIMOD 
(локальный – на уровне лесоустроительного выдела или региональный – на уровне типа 
леса в данных климатических условиях). Статистический подход является 
методическим приемом, позволяющим получить статистические оценки динамики 
ведущих переменных и оценить чувствительность модели к варьированию параметров 
и исходных данных. Вариабельность начальных значений и параметров, определяемая 
природными условиями, может быть учтена применением метода Монте-Карло 
(Ермаков, Михайлов, 1976). Уровень применимости модели зависит от степени 
генерализации параметров модели, а также от ее чувствительности к изменению 
параметров. 
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2. ОПИСАНИЕ СИСТЕМЫ МОДЕЛЕЙ EFIMOD 

Модель роста леса и круговорота элементов в лесных экосистемах EFIMOD 
(Моделирование динамики…, 2007; Chertov et al., 1999, 2003; Komarov et al., 2003) 
представляет собою индивидуально-имитирующий пространственно распределенный 
имитатор системы «дерево-почва», рассчитывающий рост каждого дерева с его 
пространственными координатами, параметры баланса угдерода и стандартные 
таксационные параметры: NPP, полнота, NEP, биомассу деревьев и древостоя по 
компонентам, пулы (запасы) ОрВП и азота почвы, средние высоту, диаметр, запасы 
древесины, полноту древостоя и некоторые другие характеристики. Обе модели – 
динамики ОрВП ROMUL и лесной экосистемы EFIMOD – были обстоятельно 
калиброваны и верифицированы в России (Моделирование динамики…), Европейском 
институте леса в Финляндии Kahle et al., 2008) и в Канаде (Chertov et al., 2009; Shaw et 
al., 2006). «Верификация» модели – это проверка результатов моделирования на 
соответствие экспериментальным данным, использованным для компиляции модели. 
«Калибрация» – это тюнинг параметров модели для наиболее полного соответствия 
экспериментальным данным. Различается базовая калибрация, выполняемая при 
создании модели, и «калибрация по месту» (site-specific calibration), которую проводят 
при использовании модели в различных условиях. «Валидация» - это тестирование 
модели после или совместно с калибрацией по независимым экспериментальным 
данным, которые не были использованы при компиляции моделей 

Ядром программы EFIMOD являются модель роста дерева (Chertov, 1990), 
почвенная модель ROMUL (Chertov et al., 2001) и генератор почвенного климата 
SCLISS (Быховец, Комаров, 2002). Кроме того, в модели имеется ряд специальных 
процедур (модулей):  
 генерация исходного размещения деревьев на моделируемой площади и при 

возобновлении; 
 расчет мозаики освещенности и локальной освещенности каждого дерева; 
 расчет площадей питания и доступного азота почвы для каждого дерева;  
 имитатор различных рубок;  
 имитатор лесных пожаров. 
 

2.1. Модель роста отдельного дерева. 
Модель роста дерева представляет собою простой имитатор прироста биомассы 

с годичным шагом (рис. 1). Прирост биомассы определяется в зависимости от света 
(доли ФАР после затенения) и почвы (вычисляемого моделью ROMUL доступного 
азота после минерализации ОрВП на площади питания дерева). В модели используются 
два расчета биологической продуктивности с использованием двух параметров: 1) 
максимальная биологическая продуктивность листвы/хвои за вегетационный период 
(αmax, кг прироста на кг биомассы листвы в год) как суммарной нетто-биологической 
продукции (НБП) дерева, растущего при полной освещенности в оптимальных 
эдафических условиях, и 2) удельное потребление азота на прирост (nT, кг азота на кг 
прироста в год). Оба прироста вычисляются, зная локальную освещенность дерева, 
функцию снижения αmax при затенении (линейная для светолюбивых и нелинейная для 
теневыносливых видов), биомассу листвы/хвои и количество доступного азота на 
площади питания дерева, вычисляемое в почвенной модели ROMUL. Реальным 
приростом принимается, согласно закону минимума Либиха, минимальный прирост из 
двух рассчитанных значений, т.к. при недостаточной освещенности избыток азота 
почвы не влияет на рост дерева, а при нехватке азота дерево не растет быстро даже при 
полной освещенности. Следует отметить, что величины αmax представляют собою 
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простейшую константу для определения НБП. Они являются видоспецифичными и 
зависимыми только от интегрального показателя тепло-обеспеченности вегетационного 
периода «сумма температур за вегетационный период». Также видоспецифичными 
являются и величины nT – чем они выше, тем выше потребность дерева в азоте для 
синтеза новой биомассы. 

 

 
Рис. 1. Блок-схема модели роста отдельного дерева. Пояснения в тексте. 

 
Далее вычисленный прирост биомассы распределяется между органами дерева 

(ствол, листья, ветви, толстые корни, тонкие корни) согласно экспериментально 
определенным видоспецифичным функциям. На этой основе рассчитываются приросты 
высоты и диаметра ствола, используя функции реаллокации, т.е. конвертации биомассы 
ствола в объем древесины, и специальные адаптационные поправки для деревьев, 
растущих при дефиците света или азота. После этого определяется масса опада 
листвы/хвои, ветвей и корней, которая переводится в почвенную модель ROMUL. В 
конце годичного шага оценивается жизненный статус дерева по двум функциям 
смертности: в зависимости от максимального возраста дерева и в зависимости от 
пропорции биомассы листвы к биомассе дерева. Если дерево оценивается, как 
нежизнеспособное, то оно назначается в отпад и все поступает в модель ROMUL. Этот 
опад служит основным компонентом влияния растительности на почвы. 

Из приведенного описания видно, что, несмотря на концептуальную простоту 
модели дерева, для нее необходимо иметь множество экологических параметров. Эти 
параметры объединены в особый входной файл для каждой древесной породы (*.int). В 
настоящее время параметризовано 6 видов Европейской России и 2 упоминавшиеся 
выше канадские хвойные породы. 

 
2.2.Модель динамики органического вещества почвы ROMUL. 
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Модель представляет собою формализацию концепции «типов гумуса» лесных 
почв и российской классической теории гумусообразования. В экосистемной модели 
EFIMOD почвенная модель выполняет функцию деструктивного звена биологического 
круговорота, т.е. разложение растительного опада и древесного отпада, в результате 
которого получается углекислый газ и минеральный азот (NH4

+, NO3
-), необходимый 

для питания растений. Углекислый газ поступает в атмосферу, а азот в модели EFIMOD 
служит основной обратной связью между почвой и лесной растительностью, определяя 
продуктивность насаждений.  

Лесоводственная концепция типов гумуса лесных почв основана на учете роли 
почвенной фауны в формировании морфологически и функционально различных типов 
переработки опада, гумификации и минерализации всего ОрВП (см. Чертов, 1981; 
Чертов и др., 2007). Эта концепция является универсальной – хорошо известные три 
основных типа гумуса – грубый гумус, модер и мулль – прослеживаются во всех 
природных зонах и во всех типах растительности. В модели типы гумуса 
параметризованы значениями коэффициентов минерализации свежего опада, 
гумифицированной подстилки/торфа и коэффициентами гумификации опада и 
трансформации органического вещества подстилки в гумус минеральных горизонтов 
двумя комплексами организмов-деструкторов: почвенной фауны мелких 
членистоногих и дожевых червей (рис. 2).  

 

 
Рис. 2. Блок-схема модели динамики оганического вещества почв ROMUL для одной 
когорты наземного и одной когорты подземного опада. Стрелки, направленные вверх – 

минерализация компонентов ОрВП. Стрелки, направленные вниз или вправо – 
гумификация компонентов ОрВП: k3  и k3S  - формирование КГВ и грубогумусной 
подстилки; k4 и k4S - гумификация ОрВП комплексом мезофауны и бактерии, 
формирующих тип гумуса «модер»; k5  и k5S  - комплекс дождевых червей, 

формирующих мягкий гумус, «мулль». 
 

Процесс гумификации опада вычисляется в два этапа. Первый этап – это 
быстрая гумификация свежего растительного опада с формированием «комплекса 
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гумусовых веществ с неразложтвшимися растительными остатками, КГВ», который 
минерализуется существенно медленнее свежего опада (Чертов, 1985). Второй этап – 
это трансформация КГВ двумя комплексами почвенной фауны и микроорганизмов в 
гуминовые вещества минеральных горизонтов почв. 

Минерализация и трансформация опада, подстилки и гумуса минеральных 
горизонтов «управляется» почвенной температурой и влажностью, а также свойствами 
опадов и ОрВП – концентрацией в опаде азота, зольностью и отношением С:N в почве. 
Значения всех коэффициентов и поправок на гидротермические условия и химический 
состав материала вычислены на основе многолетних лабораторных экспериментов по 
разложению опада и в результате анализа всей доступной научной информации (Чертов 
и др., 2007). Все указанные процессы вычисляются для неограниченного количества 
когорт любого опада и суммируются в итоге в один пул медленно разлагемого 
«стабильного гумуса». Следует подчеркнуть, что эта модель позволяет также 
рассчитывать динамику разложения древесного опада. В этом случае в модели 
отключаются коэффициенты трансформации ОрВП мезофауной и дождевыми червями 
и переноса материала в минеральные горизонты. 

Модель ROMUL, первая версия которой появилась в 1985 году, была 
обстоятельно тестирована и верифицирована на большом количестве независимых 
экспериментальных данных – от России до Канады и Австралии – и широко 
использована для решения различных теоретических и практических задач. 

 
2.3. Простой статистический генератор почвенного климата SCLISS. 
SCLISS (Быховец, Комаров, 2002) позволяет трансформировать многолетние 

ряды стандартных данных метеорологических станций и различных моделей изменения 
климата в температуру и влажность лесных почв. Кроме того, он позволяет 
генерировать долговременные ряды гидротермических условий почв по многолетним 
средним метеорологическим данным. В основе расчета лежат экспериментальные 
данные о различиях температруты почвы между стандартной открытой задернованной 
площадкой на метеостаницях и температурой почвы в лесу разного состава, а также 
некоторые другие зависимости. Так, зимой температура почвы в лесу заметно выше, 
чем на открытой площади, а летом наоборот, причем разница температур достигает 
7оС. 
 

2.4. Система моделей EFIMOD. 
Собственно сама модель EFIMOD интегрирует все три описанные выше модели 

в одну систему (рис. 3) с вычислением ряда дополнительных процедур популяционного 
и лесохозяйственного уровня. Прежде всего, это генерация исходного размещения 
деревьев на моделируемой площади и при возобновлении, которая выполняется в 
нескольких вариантах: а) регулярное размещение с заданными параметрами (лесные 
культуры); б) случайное размещение с использованием генератора случайных чисел; в) 
случайное размещение с использованием закономерностей пространственного 
распределения деревьев при естественном возобновлении и росте (Моделирование 
динамики…, 2007). 

На каждом временном шаге в модели производится расчет мозаики 
освещенности и локальной освещенности каждого дерева, в котором используются 
эмпирические данные по степени затенения под кроной каждой древесной породы и 
площади крон каждого дерева. После этого определяется степень затенения (снижения 
полной ФАР) с учетом высоты каждого дерева по отношению к высотам окружающих 
деревьев и перекрытия крон. Доступный для каждого дерева азот почвы расчитывется 
путем распределения общего минерального азота моделируемой площади на данном 
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временном шаге пропорционально площади питания каждого дерева. При этом, 
проводится достаточно сложный расчет азота в случае перекрытия площадей питания 
деревьев разеых вмдов с учетом биомассы их корней и удельного потребления азота на 
прирост биомассы. Эти величины «доступной ФАР и азота» затем используются при 
вычислении прироста биомассы каждого дерева.  

В модели EFIMOD используется сильно упрощенная процедура естественного 
возобновления. Это – введение нового «элемента леса», т.е. когорты сеянцев одной 
древесной проды с заданными значениями высоты и диаметра (если высота выше 1,3 
м), обязательно со стандартным отклонением, а также густоты (число сеянцев на 
гектар) и типа пространственного размещения. При возобновлении несколькими 
древесными породами вводится несколько «элементов леса». Возобновление может 
вводиться неограниченное количество раз на любом шаге моделирования. 

 

 
Рис. 3. Блок-схема модели EFIMOD 

 
В EFIMOD имеется имитатор рубок, позволяющий достаточно подробно вводить 

параметры рубок ухода, сплошных и выборочных рубок (по объему древесины, числу 
стволов или биомассе) с любой пропорцией удаления биомассы срубленных деревьев 
(вывоз древесины и сжигание порубочных остатков), и расчетом вырубленной 
биомассы и азота. Кроме того, при работе с канадскими данными был создан имитатор 
лесных пожаров, в котором можно задавать верховые и низовые пожары с заданной 
интенсивностью выгорания биомассы деревьев и лесной подстилки, расчетом выброса 
углекислоты в атмосферу, а также имитировать выедание биомассы листвы/хвои 
насекомыми вредителями. 

При инициализации модели в нее, прежде всего, загружается климатический 
файл различных форматов – либо с многолетними рядами данных 
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(экспериментальными или предварительно рассчитанными моделью SCLISS), либо с 
многолетними средними, которые при прогонах модели автоматически преобразуются 
в многолетние ряды моделью SCLISS. Вместе с климатическим файлом вводится 
величина поступления азота из атмосферы. Далее вносятся начальные данные по пулам 
ОрВП и азота отдельно для органических и минеральных горизонтов с возможностью 
корректировки некоторых коэффициентов минерализации ОрВП. Следующими 
загружаются файлы с экологическими параметрами видов, необходимыми для 
вычисления прироста биомассы и таксационных характеристик. Последней процедурой 
при инициализации является ввод начальных данных по параметрам древостоя. Он 
производится по «элементам леса» - когортам одного вида заданного возраста, высоты, 
диаметра и числа деревьев на гектар, точно так же, как и при моделировании 
естественного возобновления. Введенные вручную начальные параметры для 
инициализации модели могут быть сохранены в виде отдельного файла (*.lesproject) 
для удобства дальнейшего использования.  

Модель EFIMOD имеет удобный для пользователя интерфейс с анимационным 
2D и 3D представлением моделируемой площади, графическим представлением всех 
выходных данных и Монте-Карло имитацией, позволяющей минимизировать ошибки 
имитации, связанные с неопределенностью каких-либо входных данных или 
параметров модели. Это достигается путем многократных прогонов модели с 
варьированием выбранных параметров и встроенной статистической обработкой 
результатов моделирования. 

Более подробно со структурой модели EFIMOD, ROMUL и SCLISS можно 
ознакомиться в монографии «Моделирование динамики органического вещества в 
лесных экосистемах» (2007) и методическом пособии по почвенной модели (Чертов и 
др., 2007). 

Следует отметить, что в настоящее время имеется еще одна модель, 
функционально связанная с EFIMOD. Это модель биоразнообразия растительности 
напочвенного покрова BioCalc (Khanina et al. 2007). Она использует данные имитации 
EFIMOD по составу, возрасту и полноте древостоя, а также по богатству почв азотом и 
количеству валежа для оценки представленности и динамики эколого-ценотических 
групп растительности напочвенного покрова в моделируемой экосистеме. 

 
2.5. Области применения модели. 
Система моделей EFIMOD обладает рядом ограничений. В частности, 

подмодель динамики органического вещества почвы плохо работает при имитации 
почв очень сухих и очень влажных местообитаний. Модель роста отдельного дерева 
также имеет ряд ограничений. Например, она не может учитывать отрицательное 
влияние изменений климата на растения – тепловой стресс, снижение количества 
фотосинтетический активной радиации вследствие увеличения облачности и реакцию 
на изменение гидрологического режима. Это обусловлено тем, что в данной системе 
моделей используется упрощенная модель продуктивности, достоинствами которой 
является небольшое количество необходимых для инициализации параметров и 
высокое быстродействие. Эта модель может быть легко заменена детальной 
экофизиологической моделью продуктивности. Однако здесь можно отметить, что 
прогнозируемое изменение нормы осадков невелико и, к тому же, носит 
положительный характер, а увеличение среднегодовых температур и снижение 
приходящей солнечной радиации, возможно, и оказывает влияние, но при 
моделировании на относительно малых промежутках времени (сопоставимых с 
продолжительностью жизни одного поколения деревьев) данным фактором можно 
пренебречь. Также система моделей EFIMOD не учитывает эффект фертилизации 
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вследствие повышения концентрации углекислого газа в атмосфере (Wang et al., 2006). 
Однако, вопрос о росте продуктивности лесных экосистем бореального пояса из-за 
повышения концентрации CO2 остается дискуссионным (Kurz et al., 2007), поскольку 
целым рядом исследователей (Percy et al., 2002; Bond-Lamberty et al., 2007) не 
отмечалось никакого прироста продуктивности. 
 

2.6. Параметризация модели 
Для корректной работы модели она должна быть проинициализирована набором 

параметров, которые можно условно разделить на две группы: 
1. Калибровочные параметры, для которых обычно известны только допустимые 

диапазоны. Эти параметры, являясь, по сути своей, «подгоночными», позволяют 
уменьшить неопределенность начальных данных. Однако ошибка в установке 
значений подобных параметров может привести к неправдоподобным 
результатам моделирования. 

2. Начальные значения параметров состояния, т.е. собственно входные данные 
модели. Они либо известны из имеющихся в наличии существующих учетных 
или литературных данных (например, данные лесного учета или результаты 
полевых наблюдений), либо косвенно оцениваются на основе соображений 
теоретического характера. 
Сущность процедуры калибрации модели заключается в достижении 

соответствия ведущих переменных модели экспериментальным данным с некоторой 
точностью, зависящей от целей моделирования. Одновременная близость множества 
параметров к соответствующему множеству экспериментальных данных является 
косвенным доказательством полноты и непротиворечивости модели и правильности 
калибрации ее параметров. 

К первой группе параметров можно отнести, в частности, экологические 
характеристики видов, или «сильвики» (Чертов, 1983; Prentice, Helmisaari, 1991). Они 
описывают видоспецифичные характеристики роста и развития дерева. Данные 
параметры были формализованы на основе данных из работ по биологической 
продуктивности ели европейской (Picea abies L. Karst.), сосны обыкновенной (Pinus 
sylvestris L.) и березы повислой (Betula pendula L.), широко распространенных в 
бореальной зоне Европейской России (Казимиров, Морозова, 1973; Казимиров и др., 
1977, 1978). К таким параметрам относятся: 

1. Биологическая продуктивность листвы/хвои, αmax, выражается в граммах 
прироста биомассы на грамм листвы/хвои в год). 

2. Возрастной статус дерева, от которого зависит, в частности, изменение 
потенциального прироста. В модели выделяются три возрастных статуса: 
прегенеративный, генеративный и постгенеративный. Переключение между 
возрастными статусами происходит по достижении деревом определенного 
(видоспецифичного) возраста. 

3. Удельное потребление элементов почвенного питания np. Параметр 
указывает на количество грамм азота, необходимое для продукции грамма 
прироста в год. 

4. Доли опада различных органов дерева, их зольность и содержание азота 
играют важную роль для оценки динамики органического вещества почвы с 
помощью модели ROMUL. 

5. Смертность. Модель использует детерминистическую процедуру 
смертности, основанную на идее о пороговом (летальном) отношении массы 
листвы к полной биомассе дерева. В дополнение к ней функционирует 
процедура вероятностной смертности в зависимости от возраста дерева, 
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которая достигает единицы при видоспецифичном максимальном возрасте 
дерева. 

 
2.6.1. Параметризация характеристик почвы 
Поскольку в таксационных данных характеристики почвы не приводятся, они 

были оценены, исходя из двух имеющихся параметров: типа лесорастительных условий 
и доминирующего древесного вида, с использованием региональных баз данных и 
экспертных оценок (Chertov et al., 2002; Chertov et al., 2006; Честных и др., 2004). 

Параметризация характеристик почвы начинается с анализа всех имеющихся 
доступных данных по моделируемой территории. Основной задачей подобного анализа 
является построение базы данных с характеристиками основных пулов органического 
вещества почвы с привязкой к группам типов леса по Сукачеву или типов 
лесорастительных условий по Воробьеву-Погребняку (Chertov et al., 2002), т.е. к 
интегральным характеристикам эдафических условий на участке, к которым относятся, 
в первую очередь, водный режим и богатство почвы (Ремезов, Погребняк, 1965; 
Чертов, 1981). При этом предполагается, что группы типов леса или типов 
лесорастительных условий (ТЛУ) удовлетворительно коррелируют с экологическими 
группами почв (Чертов, 1981). 

Основными переменными модели ROMUL являются характеристики пулов 
свежего опада, гумуса органических горизонтов и гумуса минеральных горизонтов 
почвы, а именно содержание в них органического вещества и азота. Следует особо 
отметить, что речь идет именно о пулах органического вещества, а не о аналитически 
определяемом углероде. 

Возможны два метода оценки этих характеристик. 
 Если известны объемная плотность органического горизонта почвы Dv и его 

мощность Z, тогда количество органического вещества ОрВП (SOM) в 
горизонте на единицу площади может быть легко вычислено по формуле (1). 

SZDSOM V  ,  (1)
где S – единица площади (например, квадратный метр). 

 Если величина объемной плотности для органических горизонтов отсутствует, 
то количество ОрВП может быть вычислено по регрессионному уравнению (2) 
для лесных почв бореальной зоны, рассчитанное по данным, приведенным в 
книге О.Г.Чертова (1981). 

20048.03462.05301.0 ZZSOM  ,  (2)
где Z, как и ранее – мощность органического горизонта (в см), SOM – 

количество органического вещества, кг/м2. 
Пул азота органического горизонта вычисляется по полученным данным для 

ОрВП и концентрации азота в соответствующем горизонте (или по отношению C/N). 
Пулы органического вещества в минеральных горизонтах почвы 

рассчитываются согласно предыдущим уравнениям (1, 2), а затем суммируются для 
всех минеральных горизонтов до 100 см глубины. 

Вычисленное значение пула ОрВП в минеральных горизонтах необходимо 
рассматривать как сумму лабильной и стабильной фракций гумуса. Для инициализации 
модели необходимо разделить суммарный пул ОрВП на эти две фракции. 

По умолчанию в модели предполагается, что лабильная фракция составляет 0.4 
от всего органического вещества минеральных горизонтов. В естественных почвах во 
всех климатических зонах эта доля колеблется между 0.5 и 0.2 (в богатых гумусом 
почвах избыточного увлажнения эта доля может быть даже выше, например, в 
темноцветных, перегнойных и луговых глеевых почвах). Деградированные пахотные и 
пастбищные почвы могут иметь долю лабильной фракции меньше 0.1. 
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Если доступно достаточно большое количество описаний лесоустроительных 
выделов, то может быть применена следующая процедура определения запасов ОрВП и 
азота почвы в качестве входных параметров для модели EFIMOD: 

1. Для каждой преобладающей породы в локальных пределах (лесничество, 
несколько кварталов и т.п.) устанавливается распределение выделов по ТЛУ 
(или группам типов леса). 

2. Для каждой доминантной породы в распределении по ТЛУ оценивается 
распределение выделов по классам бонитета. 

3. Так же для каждой доминантной породы внутри распределения по классам 
бонитета определяется возрастная структура древостоев: молодые, 
средневозрастные, спелые, перестойные. 

4. Для каждого ТЛУ (или группы типов леса) создается сценарий 
гидротермического режима почв с помощью климатического генератора 
SCLISS. 

5. Для каждого ТЛУ (или группы типов леса), древесной породы, класса бонитета 
и возрастной группы делаются прогоны модели EFIMOD на 100 лет для 
молодых и на 50 лет для спелых насаждений в режиме Монте-Карло с не менее 
чем 10 повторностями и с 50-процентной вариацией начальных почвенных 
условий. 

6. Для каждого ТЛУ, преобладающей породы и возрастной группы определяется 
средневзвешенная по распределению классов бонитета динамика основных 
почвенных характеристик: ОрВП и азот подстилки, лабильный гумус, 
стабильный гумус. 

7. Значения выходных параметров ОрВП в конце 100 летнего периода имитации 
усредняются для каждого ТЛУ и преобладающей породы и далее используются 
как начальные значения для последующих прогонов модели (Моделирование 
динамики … , 2007). 

 
2.7. Описание модуля пакетной обработки 

2.7.1. Назначение модуля пакетной обработки, принципы работы 
Как уже упоминалось выше, система моделей EFIMOD является индивидуально-

ориентированной и предназначена для оценки динамики лесных экосистем на 
локальном уровне, при этом рост каждого дерева моделируется отдельно (Комаров, 
2010). Инициирующие параметры модели задаются вручную, т.е. вводятся с 
клавиатуры или загружаются из входного файла. Аналогичным образом 
осуществляется управление развитием имитируемого участка, в т.ч. задание 
параметров различных внешних воздействий (рубки, посадки, пожары). 

Однако при прогнозировании развития лесных экосистем нередко возникает 
задача моделирования роста древостоя на больших территориях (в масштабах 
лесничества и больше), где элементарной единицей обработки является один выдел. 
Такой подход позволяет, с одной стороны, оценить динамику территории в целом и 
выявить некие общие закономерности, и, с другой стороны, сохранить высокий уровень 
детализации, при котором можно анализировать динамику каждого конкретного 
участка (выдела), что дает возможность для проведения сравнительного анализа. Такой 
подход также позволяет использовать результаты моделирования при построении 
геоинформационных систем и пространственном анализе. 

Его недостатком является трудоемкость, так как необходимо вводить 
инициирующие параметры модели и проводить имитационный эксперимент по 
определенному сценарию для каждого участка. С целью автоматизации данного 
процесса автором диссертации было разработано дополнение к текущей версии 
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системы моделей EFIMOD – специальный модуль EFIMOD.Batch, реализующий 
пакетный режим работы (Шанин и др., 2009; Шанин, 2011), при котором задание 
инициирующих параметров и сценария развития леса на тестовом участке 
осуществляется автоматически, без участия пользователя. Входные параметры для 
инициализации модели считываются из базы данных, в которых каждая запись 
содержит характеристику одного выдела. 

Разработанный модуль имеет ряд функциональных особенностей: 
 он является надстройкой над стандартной версией модели, допускающей 

моделирование отдельных участков в обычном режиме. 
 EFIMOD.Batch не требует оформления данных в специальном формате – в 

качестве входных файлов используются базы данных в широко 
распространенном формате Microsoft® Office Access. 

 EFIMOD.Batch обладает большой гибкостью при конструировании сценариев 
развития имитируемых участков, позволяя более детально описать систему 
лесохозяйственных мероприятий. 
Как известно, любая база данных в самом общем виде представляет собой 

совокупность записей. В данном случае одна запись содержит характеристику одного 
выдела. При этом для работы модели необходимо, чтобы база данных содержала 
следующую информацию, которую можно разбить на две группы: 
1. Характеристики выдела в целом. 

 Идентификатор выдела (желательно, чтобы он представлял собой числовое 
значение). 

 Доминирующая порода. 
 Характеристики пулов органического вещества почвы. 
 Плотность почвы. 
 Запас сухостоя и виды, формирующие его. 
 Также модуль пакетной обработки может использовать при работе следующие 

необязательные поля: имя файла с климатическими данными, имя файла 
описания сценария, тип лесорастительных условий. 

2. Характеристики отдельных элементов древостоя. 
 Идентификатор выдела (желательно, чтобы он представлял собой числовое 

значение). 
 Вид дерева. 
 Возраст. 
 Средняя высота. 
 Средний диаметр на высоте груди. 
 Число деревьев на гектар. 

Модуль EFIMOD.Batch позволяет: 
1. Осуществить подключение к базе данных, содержащей необходимую 

информацию. 
2. Задать настройки импорта, т.е. соответствие между необходимыми входными 

данными и именами полей, в которых они содержатся. 
3. Провести проверку содержащейся в базе информации на валидность 

(соответствие хранящейся в полях информации ассоциированному с ним 
параметру; а также отсутствие нулевых значений). 

4. Задать настройки сохранения результатов моделирования (какие из выходных 
параметров следует сохранять). 

5. Применять к входным данным различные фильтры, позволяющие выбрать для 
моделирования только выделы с определенными характеристиками. 
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2.7.2. Конструктор сценариев: назначение и принципы работы 

Важным элементом моделирования динамики древостоя является управление 
развитием имитируемого участка, т.е. задание некоего сценария лесопользования. Для 
реализации таких сценариев был создан специальный модуль. С целью определения 
требований к функциональным возможностям такого конструктора были 
проанализированы литературные источники (Основные положения…, 1993; 
Инструкция , 1997; Желдак, Атрохин, 2002). 

Конструктор сценариев позволяет задавать: 
 Продолжительность периода моделирования. 
 Целевые породы. 
 Различные воздействия на имитируемый участок (рубки, посадки, пожары).  
 Возраст рубки и продолжительность классов возраста. 
 Порядок рубки по видам, т.е. очередность, в которой виды, присутствующие на 

имитируемом участке, будут отводиться в рубку. 
Модуль EFIMOD.Batch позволяет задавать различные режимы возобновления 

леса с помощью системы посадок, в т.ч. имитировать естественное возобновление. 
Каждая посадка имеет ряд параметров. 

Распределение деревьев на имитируемом участке при имитации посадки может 
быть случайным или равномерным по решетке (с указанием расстояния между рядами). 

При посадке задаются параметры элемента леса: возраст, количество деревьев 
на 1 га, средняя высота, средний диаметр на уровне груди, стандартные отклонения для 
высоты и диаметра. 

Видовой состав возобновления может зависеть от типа лесорастительных 
условий, либо от видового состава древостоя на участке перед выполнением посадки. 
Также возможно указание конкретного вида, который будет сажаться. 

Время проведения посадки может задаваться: 
 На определенном шаге моделирования. 
 Спустя определенный срок после рубки. 
 После гибели всех деревьев на имитируемом участке. 
 При определенном возрасте древостоя. 

В зависимости от текущего состояния древостоя и заданных условий (например, 
если один из параметров древостоя больше (или меньше) заданного порогового 
значения), посадка может быть отменена. 

Как уже говорилось выше, видовой состав возобновления в зависимости от ТЛУ 
задается пользователем в виде списка, где одному (или группе) типов 
лесорастительных условий ставится в соответствие процентное соотношение разных 
видов деревьев в составе посадки. 

После запуска процесса пакетной обработки начинается выполнение 
расширенного сценария в соответствии с заданными в нем параметрами. При этом 
перед обработкой каждого участка выполняется ряд предварительных операций. 

Для всех видов, имеющихся в базе данных, происходит расчет границ групп 
возраста. При этом учитываются два параметра, заданных пользователем: возраст 
рубки главного пользования и продолжительность класса возраста. 

Группы возраста определяются следующим образом: 
 Молодняки – до 3-го класса возраста. 
 Средневозрастные – с 3-го класса возраста. 
 Приспевающие – за 2 класса возраста до наступления возраста рубки главного 

пользования. 
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 Спелые – начиная с возраста рубки. 
 Перестойные – спустя 4 класса возраста после наступления возраста рубки 

главного пользования (Желдак, Атрохин, 2002). 
Затем происходит формирование списков воздействий на имитируемый участок 

– составляются списки рубок, посадок и пожаров. В случае если некоторые из 
параметров сценария (например, количество подсаживаемых деревьев или 
интенсивность пожара) заданы случайными числами, производится расчет значений 
этих параметров. 

Для каждого обрабатываемого участка определяется целевой вид. В зависимости 
от заданных условий, он может определяться либо, исходя из типа лесорастительных 
условий по Погребняку-Воробьеву (Желдак, Атрохин, 2002) (обычно этот параметр 
указывается в лесоустроительных базах данных), либо целевой вид определяется как 
вид с максимальным запасом. При этом проводится проверка, присутствует ли на 
обрабатываемом в данный момент участке целевой вид. При отрицательном результате 
такой проверки в качестве целевого вида назначается доминирующий. 

Рассчитывается возраст древостоя как возраст самой старшей когорты, 
принадлежащей к целевому виду. Если определение целевого вида для 
обрабатываемого участка невозможно, возраст древостоя определяется как возраст 
самой старшей когорты, принадлежащей к доминирующему виду. 

После успешного выполнения этих предварительных операций запускает 
процесс моделирования, в ходе которого также производится ряд действий, связанных 
с обработкой параметров сценария. 

Так, на каждом шаге моделирования осуществляется расчет соотношения видов 
(доля каждого вида (по запасу) представляется в виде долей единицы). Вид с 
максимальной долей определяется как доминирующий. 

Также осуществляется проверка, не наступило ли время (или условие) для 
запуска какого-либо из заданных воздействий на имитируемый участок (посадок, 
рубок, пожаров). В случае если совпадает время (или выполняется условие), 
запускается данное воздействие. 

Таким образом, механизм сценариев позволяет моделировать развитие 
имитируемого участка, включая систему внешних воздействий на него. При этом 
сценарий отличается адаптивностью и, в зависимости от условий и параметров, будет 
индивидуален для каждого моделируемого участка. 
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3. ИНТЕРФЕЙС СИСТЕМЫ МОДЕЛЕЙ EFIMOD 
3.1 Общий обзор интерфейса. 
На рисунке ниже указаны основные элементы интерфейса главного окна 

системы моделей. 
 

 
 

Помимо карты размещения деревьев, возможны варианты представления 
результатов моделирования в виде распределения зон затенения (слева вверху), зон 
почвенного питания (справа вверху), в виде графиков (слева внизу) или трехмерного 
представления (справа внизу). 
 

 

 
 

Режимы представления также можно переключать с помощью пунктов меню 
View>Graph, View>Map и View>3D Viewer или кнопок 
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на панели инструментов. 
 

3.2. Базовые действия. 
Для начала работы можно либо создать новый проект, используя пункт меню 

File>New Project, либо открыть существующий проект с помощью пункта меню 
File>Open Project или с помощью кнопки 

 
на панели инструментов. 

После этого появляется окно редактирования свойств проекта, в котором 
задаются параметры имитационной решетки, используемый климатический сценарий, 
входные параметры подмодели динамики ОрВП (запасы органического вещества и 
азота в разных горизонтах почвы), видоспецифичные параметры и начальные данные 
по элементам леса (вид, средняя высота и диаметр на уровне груди, возраст, количество 
деревьев на 1 га). 

После подтверждения всех параметров нажатием кнопки OK в окне Project 
properties необходимо произвести инициализацию системы моделей с помощью пункта 
меню Run>New (F9) или кнопки 

 
на панели инструментов. После инициализации становятся доступными все опции 
интерфейса. 

Для возврата к редактированию свойств проекта можно использовать кнопку  

 
на панели инструментов или пункт меню View>Project properties. Необходимо помнить, 
что для того, чтобы внесенные изменения вступили в силу, требуется повторная 
инициализация системы моделей. 

Для начала моделирования надо задать требуемое количество шагов в 
соответствующем поле ввода на панели инструментов и использовать кнопку 

 
или пункт меню Run>Step. По достижении указанного шага моделирования процесс 
будет автоматически остановлен. Для принудительной остановки можно использовать 
кнопку 

 
или пункт меню Run>Stop (Ctrl+Alt+S). 

Текущий проект можно сохранить с помощью пункта меню File>Save Project. 
Необходимо отметить, что в интерфейсе системы моделей отсутствует опция 
«Сохранить как…», и вызов опции сохранения проекта автоматически предлагает 
сохранить его под другим именем. 

Возможно сохранение результатов моделирования в текстовый файл в формате 
CSV (comma-separated values – значения, разделенные запятой). Данная опция 
вызывается посредством пункта меню File>Save Results (F2) или кнопкой 

 
на панели инструментов. Также возможно сохранения информации в виде карты (пункт 
меню File>Save map). 
 

3.2.1. Параметры проекта. 
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Окно редактирования свойств проекта позволяет изменить все его параметры. 
Оно имеет 5 закладок. На первой закладке (General) расположены общие свойства 
проекта. 

 
 

Блок Size of plot регулирует размеры имитационной решетки: ее ширину и 
высоту, а также высоту и ширину клеток имитационно решетки. Опции Tree organ 
biomass и Nitrogen in Tree organs указывают программе, необходимо ли рассчитывать и 
выводить на графиках биомассу и содержание азота по органам деревьев. Опция Group 
results by species позволяет группировать видоспецифичные результаты моделирования 
по видам, а не по элементам леса. 

Закладка Climate позволяет посмотреть характеристики используемого в проекте 
климатического сценария. Кнопка Open позволяет загрузить климатические данные из 
файла, а кнопка 

 – сохранить загруженный климатический сценарий в файл. Кнопка Set montly 
nitrogen deposition задает количество азота, поступающего в экосистему с 
атмосферными осадками. 
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Закладка Soil имеет две вложенные закладки. На первой из них (Soil parameters) 

задаются запасы органического вещества и азота в разных горизонтах почвы: 
органогенных (CHS) и минеральных (Humus). На второй закладке задаются 
коэффициенты, в частности, коэффициент K6, регулирующий скорость разложения 
стабильного гумуса. 

Закладка Species имеет 5 вложенных закладок. Она позволяет редактировать 
биологические и экологические параметры видов (виды деревьев выбираются из 
ниспадающего списка). Опция Change color позволяет изменить цвет, которым вид 
будет обозначаться на карте имитируемого участка. Кнопка Open позволяет загрузить 
характеристики видов из файла, а кнопка 

 – сохранить загруженные характеристики в текстовый файл. 
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На вложенной вкладке Age указываются границы групп возраста (в EFIMOD 
выделяются 3 группы возраста – молодые, зрелые, стареющие – и, соответственно, 
имеются 2 пороговых значения для возраста). На этой же вкладке для разных групп 
возраста указаны значения максимальной биологической продуктивности и 
коэффициенты распределения прироста биомассы по разным органам дерева. 

На вложенной вкладке Compartments для различных органов дерева (ствола, 
ветвей, листвы/хвои, скелетных корней, тонких корней) задаются: удельное 
потребление азота Nt, содержание азота в опаде N content in L., зольность опада Ash 
content in L. и доля биомассы органа, отправляющаяся в опад на каждом шаге системы 
моделей, т.е. ежегодно (Litter portion). 

На вложенной вкладке Competition указаны параметры роста зон затенения и 
почвенного питания в зависимости от высоты и диаметра дерева, а также коэффициент 
прозрачности кроны. 

На вложенной вкладке Adaptation в разделе Reallocation указаны параметры 
перераспределения прироста ствола дерева в высоту и диаметр. Группа параметров 
Increment-dependent mortality определяет пороговое значение прироста биомассы 
листвы к общему приросту (level) и максимальную продолжительность периода 
угнетения (period). Если прирост ниже чем level в течение периода времени, большего
ем period, имитируется гибель дерева. Группа параметров Age-dependent mortality 
содерж

 
ч

ит параметры функции вероятностной смертности деревьев. 
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На вложенной закладке Other указываются коэффициенты уравнения пересчета 
биомассы дерева в запас и поправочные коэффициенты функции вероятностной 
смертности. 

На закладке Forest elements указывается список элементов леса, которые 
необходимо «посадить» на участке при инициализации системы моделей. Для каждого 
элемента указываются стандартные характеристики: вид, высота и диаметр (и их 
стандартные отклонения), число деревьев на 1 га. 
 

3.2.2. Запуск EFIMOD с параметрами командной строки. 
Запуск системы моделей EFIMOD возможен с указанием параметров командно

троки: 

начинается исполнение данного набора. 

ия входных данных. 
Все параметры разделяются пробелом. При пропуске какого-либо из параметров 

все последую
 

3. Инструменты. 

варьи де Монте-Карло см. Ермаков, 
Михайлов

кнопки

й 
с

1. Имя проекта, который следует открыть и проинициализировать. 
2. Имя файла с набором макрокоманд (см. ниже). Если он указан, сразу 

3. Если третьим параметром является MC, программа запускается в режиме 
Монте-Карло (см. ниже). Требует дополнительных параметров: 
количество «прогонов», продолжительность периода моделирования, 
значение коэффициенты варьирован

щие игнорируются. 

3.
3.3.1. Статистическое моделирование методом Монте-Карло. 

Данный инструмент позволяет оценить чувствительность модели к 
рованию входных данных (подробнее о мето

, 1976). 
Инструмент вызывается с помощью пункта меню Run>Monte-Carlo (Ctrl+M) или 
 

 
на панели инструментов. 
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Появляется окно настроек инструмента: 
 

 
 

В окне необходимо задать количество «прогонов» модели (Runs), количество 
шагов моделирования (Years) и, при желании, выбрать макрос (Macros; о макросах 
EFIMOD см. ниже). В блоке Soil parameters указаны все параметры, для которых 
процедура Монте-Карло будет задавать варьирование, и размер варьирования, % (Set 
up Sigma). В блоке Calculate галочками можно отметить параметры, которые модель 
должна рассчитать. 

После завершения расчетов окно настроек процедуры Монте-Карло 
автоматически закроется, и станет возможным просмотр результатов моделирования. В 
отличие от стандартного режима работы (см. ниже), в режиме Монте-Карло для 
каждого из выходных параметров системы моделей доступен просмотр не только 
значений самого параметра, но и рассчитанных для него стандартных отклонений: 
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3.3.2. Инструмент имитации возобновления 
Инструмент вызывается посредством пункта меню Tools>Add forest element… 

или кнопки 

 
на панели инструментов. Появляется окно с параметрами возобновления. 

В окне необходимо задать параметры возобновления: высаживаемый вид (Tree 
pecies), идентификатор нового элемента леса (Name of new Forest Element), возраст
ge), средни уди (Mean DBH, м) и их 

станда

гулярное или разные виды неравномерного. В блоке Planting scheme 
задаются параметры расположения деревьев при регулярном расположении. 

с заданными 
параме

S
(A

 
е высоту (Mean H, м), диаметр на уровне гр

ртные отклонения (St. Deviation), а также количество высаживаемых деревьев на 
1 га (Number of trees/ha). В блоке Spacing задается пространственное распространение 
деревьев: ре

После нажатия кнопки OK добавляется новый элемент леса 
трами. 
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3.3.3. Инструмент имитации рубок. 
Инструмент вызывается посредством пункта меню Tools>Thinning… или кнопки 

 
на панели инструментов. Появляется окно настроек инструмента: 
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В окне необходимо задать параметры рубки: отводимый в рубку элемент леса 

(Forest element, можно отвести в рубку все элементы леса – пункт All); метод рубки 
(Type of cutting – верховой или низовой); интенсивность рубки (%) и критерий 
интенсивности (биомасса, количество деревьев, сумма площадей сечений или запас). В 
блоке Portion going away задаются доли разных наземных органов дерева (стволов, 
ветвей, листьев, в %), удаляемых с порубочной площадки. Оставшаяся часть надземной 
биомассы и вся подземная (скелетные и тонкие корни) считается порубочными 
остатками и обрабатывается как опад в подмодели динамики органического вещества 
почвы. После проведения рубки демонстрируется окно с результатами, где указана 
общая биомасса (и запас древесины), удаленные с участка в процессе рубки. 

 

 
 

3.3.4. Инструмент имитации пожаров. 
Инструмент вызывается посредством пункта меню Tools>Fire… или кнопки 

 
на панели инструментов. Появляется окно настройки инструмента: 
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В окне необходимо задать параметры имитации пожара – доли (%) сгорающего 
органического вещества в разных пулах: свежем опаде, подстилке, компартментах 
дерева. После имитации пожара демонстрируется окно с результатами: массой 
сгоревшего органического вещества и объемом эмиссии углекислого газа. 
 

3.3.5. Инструмент имитации «внешних» опадов. 
Данный инструмент предназначен для имитации дополнительных потоков опада 

(например, опада живого напочвенного покрова) или для имитации внесения 
удобрений. Инструмент на каждом шаге модели (ежегодно) добавляет новую когорту 
опада, которая обрабатывается в подмодели динамики органического вещества почвы. 
Вызывается с помощью пункта меню Tools>External litter fall… или кнопки 

 
на панели инструментов. Появляется окно настроек инструмента: 
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В окне задаются параметры: имя новой когорты опада (Cohort name), количество 
опада (Annual input), содержание азота (Nitrogen content) и зольность (Ash content). 
Можно указать, является ли данная когорта надземной или подземной (галочка 
Underground Cohort). Блок Monthly load позволяет распределить поступление 
«внешнего» опада по месяцам. После задания параметров новая когорта добавляется в 
список List of external cohorts с помощью кнопки Add. Когорты в данном списке можно 
редактировать (Edit), удалять (Remove) или делать неактивными (Active). Таким 
образом, можно имитировать несколько «внешних» когорт опада с разными 
свойствами. 
 

3.3.6. Прочие инструменты. 
Инструмент, устанавливающий новое значение коэффициента К6 (регулирует 

скорость разложение стабильного гумуса) вызывается посредством пункта меню 
Tools>Set K6 value. Новое значение коэффициента вводится в появляющемся окне. 

 

 
 
Инструмент «Внешние данные» позволяет добавить экспериментальные данные 

(в виде точке) на графики с данными, полученными в процессе моделирования, с целью 
их сравнения. Вызывается посредством пункта меню Tools>External Data… или кнопки 
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на панели инструментов главного окна программы. 

Инструмент, вызываемый с помощью пункта меню Tools>Species parameters…, 
позволяет в наглядном виде, с помощью столбчатых диаграмм, сравнивать параметры 
разных видов: 

 

 
 

Инструмент «Гистограмма» вызывается с помощью меню Tools>Hystogram… 
или кнопки 

 
на панели инструментов главного окна. 

Инструмент позволяет просмотреть в табличном или графическом виде 
гистограмму распределения высот и диаметров всех деревьев в имитируемом древостое 
(для всех видов, для какого-то конкретного вида, или для какого-то конкретного 
элемента леса). 
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3.3.7. Наборы макрокоманд EFIMOD (макросы). 

Макросы являются наборами макрокоманд (см. ниже), управляющих 
поведением программы, и позволяют, до некоторой степени, автоматизировать работу с 
системой моделей. Макросы сохраняются в текстовых файлах с расширением .lesscript. 

Запуск макроса осуществляется с помощью пункта меню Tools>Macros>Open 
macros… или кнопки 

 
на панели инструментов. При вызове опции появляется диалог открытия файла, и 
выбранный с помощью этого диалога файл макроса сразу запускается на выполнение. 
Все макросы, находящиеся в поддиректории data рабочей директории программы, 
будут автоматически обнаружены при старте программы и помещены в список, 
размещенный в подменю Tools>Macros после горизонтальной черты, а также в 
ниспадающем списке у соответствующей кнопки на панели инструментов. Текст 
макроса отображается в правой части главного окна программы на вкладке Macros. 
Данная вкладка является «плавающей», т.е. содержимое ее можно «перетащить» в 
отдельное окно: 
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Файл макроса также можно открыть для редактирования, не запуская его на 
выполнение. Сделать это можно посредством пункта меню Tools>Macros>Edit macros… 
главного окна программы, или кнопки 

 
окна редактирования макроса. На панели инструментов имеются и другие кнопки: 

 
позволяет сохранить редактируемый в окне макрос в файл. 

 
запускает редактируемый в окне макрос на исполнение. 

 
инициирует запись макроса. Эта опция также возможна через пункт меню 
Tools>Macros>Begin record главного окна программы. В режиме записи макроса все 
действия пользователя (запуск моделирования на определенное количество шагов, 
вызов инструментов и т.п.) сохраняется в окне редактирования макроса в виде набора 
макрокоманд с параметрами. 

Кнопки панели инструментов окна редактирования макроса продублированы 
соответствующими пунктами меню данного окна. Кнопки Fold/Unfold переключают 
окно между «свернутым» и «обычным» видом: 

 

 
 

Каждая макрокоманда записывается в файле макроса отдельной строкой, 
оканчивающейся точкой с запятой. После имени команды в круглых скобках 
указываются ее параметры, разделенные запятой. Даже если команда не имеет 
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параметров, обязательно указывать после ее имени пустые круглые скобки. EFIMOD 
поддерживает следующие макрокоманды: 

 SetStep – переход на определенное число шагов. Пример: SetStep(20); 
Данная функция имеет всего один параметр: 

1. Количество шагов (Целое число). 
 SetNewElement – имитация посадки нового элемента леса. Пример: 

SetNewElement(Birch,Birch01,5,1.5,0.95,%2000,0.75,0.75,1,1,1,5,5,BA); 
Данная функция имеет следующие параметры, по порядку: 

1. Вид дерева (Строковое значение, допустимы все символы английского 
алфавита, цифры и знак подчеркивания). 

2. Название элемента леса (Строковое значение, допустимы все символы 
английского алфавита, цифры и знак подчеркивания). 

3. Возраст деревьев (Целое число). 
4. Средняя высота деревьев (Дробное число). 
5. Средний диаметр деревьев на уровне груди (Дробное число). 
6. Количество деревьев на 1 гектар (Целое число, знак «%» перед числом 

означает, что нужно высаживать не указанное в параметре число 
деревьев данного вида, а долю от этого числа, пропорциональную доле 
данного вида в древостое, уже существующем до имитации подсадки). 

7. Стандартное отклонение для высоты (Дробное число). 
8. Стандартное отклонение для диаметра (Дробное число). 
9. Тип распределения деревьев на участке (Целое число, возможные 

значения: 0 – равномерно, 1 – случайно, 2 – сверхслучайно, 3 – 
управляемо случайно). 

10. Стартовая клетка по горизонтали (Целое число). 
11. Стартовая клетка по вертикали (Целое число). 
12. Расстояние между горизонтальными рядами (Дробное число). 
13. Расстояние между вертикальными рядами (Дробное число). 
14. По какому критерию учитывать долю участия вида (BA – сумма 

площадей сечений, GS – запас, BM – биомасса, TN – число деревьев на 1 
га). 

 SetCutting – имитация рубки. Пример: SetCutting(All,All_338,0,50,0,60,40,5); 
Данная функция имеет следующие параметры, по порядку: 

1. Название элемента леса, отводимого в рубку (Строковое значение, 
допустимы все символы английского алфавита, цифры и знак 
подчеркивания; All – все элементы). 

2. Название рубки (Строковое значение, допустимы все символы 
английского алфавита, цифры и знак подчеркивания). 

3. Метод рубки (Целое число, возможные значения: 0 – низовой, 1 – 
верховой). 

4. Интенсивность рубки, в процентах (Целое число). 
5. Критерий, по которому рассчитывается интенсивность рубки (Целое 

число, возможные значения: 0 – биомасса, 1 – количество деревьев, 2 – 
сумма площадей сечений, 3 – запас). 

6. Процент биомассы стволов, вывозимой с участка (Целое число). 
7. Процент биомассы ветвей, вывозимой с участка (Целое число). 
8. Процент биомассы листьев, вывозимой с участка (Целое число). 

 SetFire – имитация пожара. Пример: SetFire(100,80,0,0,0,0,1,false); 
Данная функция имеет следующие параметры, по порядку: 
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1. Доля (по массе) сгоревших подстилки и сухостоя, в процентах (Целое 
число). 

2. Доля (по массе) сгоревшего органического вещества почвы, в процентах 
(Целое число). 

3. Доля (по массе) сгоревших стволов, в процентах (Целое число). 
4. Доля (по массе) сгоревших ветвей, в процентах (Целое число). 
5. Доля (по массе) сгоревших тонких корней, в процентах (Целое число). 
6. Доля (по массе) сгоревших листьев, в процентах (Целое число). 
7. Коэффициент смертности (Дробное число). 
8. Поступают ли сгоревшие остатки в опад (Строковый параметр, 

возможные значения: true – да, false – нет). 
 AddExtLitter – имитация поступления «внешнего» опада. Пример: 

AddExtLitter(L0,0.15,0.0053,2,0,1,0,0,0,0,0,0,0,0,0,0,0,0); 
Данная функция имеет следующие параметры, по порядку: 

1. Имя когорты опада (Строковое значение, допустимы все символы 
английского алфавита, цифры и знак подчеркивания). 

2. Ежегодное поступление (Дробное число). 
3. Содержание азота (Дробное число). 
4. Зольность (Дробное число). 
5. Подземная (0) или надземная (1) когорта (Целое число). 
6-17. Распределение опадов по месяцам (Целое число). 
18. Является ли когорта «внешней» (0 – нет, 1 – да). 

 RemoveExtLitter – удаление когорты «внешнего» опада из списка. Пример: 
RemoveExtLitter(1); 
Данная функция имеет всего один параметр: 

1. Индекс когорты в общем списке (Целое число). 
 SetK6 – задает новое значение коэффициента K6. Пример: SetK6 (0.0006); 

Данная функция имеет всего один параметр: 
1. Новое значение коэффициента (Дробное число). 

 SaveResults – сохраняет результаты моделирования в файл. Пример: 
SaveResults(Data\scen_test.csv); 
Данная функция имеет всего один параметр: 

1. Имя файла (Строка, если параметр равен %PR_NAME%, результаты 
сохраняются в файле с именем текущего проекта и расширением .csv). 

 AppClose – закрывает программу. Пример: AppClose(); 
Данная функция не имеет параметров. 

 
3.4. Работа с графиками. 
Основным средством отображения результатов моделирования в системе 

моделей EFIMOD являются графики, отображающие динамику основных 
характеристик моделируемой экосистемы во времени. Для вывода результатов на 
графике надо выделить галочками соответствующие параметры правой части главного 
окна программы на закладке Graph. 

Редактирование свойств диаграмм возможно либо с помощью щелчка правой 
клавишей мыши на свободном пространстве и выбора в контекстном меню опции 
Graph Options, либо по щелчку левой клавишей мыши на линии графика. Любое из этих 
действий вызывает окно редактирования свойств, где можно настроить внешний вид 
диаграммы. 
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В контекстном меню диаграммы также доступны другие опции. Save сохраняет 
диаграмму в виде графического файла. Copy As… копирует диаграмму в буфер обмена 
либо в виде набора данных, либо в виде графического файла. 
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4. ИСПОЛЬЗОВАНИЕ ДИНАМИЧЕСКИХ МОДЕЛЕЙ ДЛЯ РЕШЕНИЯ 
РАЗЛИЧНЫХ ТЕОРЕТИЧЕСКИХ И ПРАКТИЧЕСКИХ ЗАДАЧ В 
ЛЕСОВОДСТВЕ 

Выше отмечалось, что не все лесные модели могут воспроизводить 
естественную динамику лесов, т.е. взаимозависимое развитие лесной растителности и 
почвы. Поэтому в этом разделе основное внимание будет уделено опыту авторов по 
применению динамической модели лесной экосистемы EFIMOD, позволяющей 
отслеживать изменение древостоев и почвы под влиянием природных и хозяйственных 
факторов. Модель EFIMOD была использована для выявления факторов повышения 
производительности лесов в Западной Европе (проект RECOGNITION) и для 
определения эффекта влияния изменения климата на таежные экосистемы (Chertov et 
al., 2005; Bhatti et al., 2005; Shaw et al., 2006). Специальная версия этой модели  
(IMPACT, Chertov et al., 2003) до сих пор используется в Финляндии для расчета 
выноса азота и углерода из лесных экосистем при экологической сертификации 
древесного сырья и продуктов переработки древесины. В последние годы EFIMOD 
использовался для оценки различных режимов ведения лесного хозяйства, расчетов 
поступления азота из атмосферы и оценки изменения климата на части территории 
лесхоза “Русский лес” в центральной России (Chertov et al., 2005; Моделирование 
динамики…, 2007). Рассмотрим более подробно полученные результаты. 

 
4.1. Применение модели EFIMOD на уровне насаждения (лесной 
экосистемы). 

4.1.1. Тенденции роста европейских лесов. 
В последнюю декаду ХХ века немецкие лесоводы обнаружили, что леса 

Западной Европы стали расти быстрее, несмотря на заметное негативное влияние 
промышленного загрязнения (Kahle et al., 2008). Среди возможных причин этого 
явления называлось изменение возрастной структуры древостоев, снижение частоты 
лесных пожаров, прекращение сбора лесной подстилки на удобрение и, наконец, 
прямое воздействие природных факторов на рост древесных пород, главным образом 
потепление климата и возрастание концентрации в атмосфере углекислого газа. 
Выяснению влияние природных факторов был посвящен проект RECOGNITION 
Европейского института леса. Объектом исследований служили 90 постоянных 
пробных площадей в Финляндии, Швеции, Шотландии, Чехии, Австрии и Германии. В 
проекте были задействованы две группы: экпериментальная и математическая. 
Экспериментальная группа анализировала данные указанных пробных площадей, 
математическая проводила вычисление роста леса на 22-х пробных площадях с 
длительным периодом наблюдений с 80-летней имитацией по трем временным 
интервалам: прошлое – с 1920 г, настоящее – с 1960 г и будущее – с 200 г. 
Использовались четыре лесные модели: две эколого-физиологические - шотландская 
EFM и финская FinFor, шведская теоретическая Q и EFIMOD (Моделирование 
динамики…, 2007). 

В результате этой работы было установлено, что основным фактором 
возрастания продуктивности древостоев во второй половине 20-го века было высокое 
поступление окислов азота из атмосферы, содержащихся в выхлопных газах двигателей 
внутреннего сгорания  (Рис. 4). Влияние изменения климата проследивается только в 
XXI веке. Однако анализ результатов моделирования в EFIMOD показал, что при 
возрастании продуктивности леса, сильно изменяются и свойства почвы (рис. 5). При 
возрастании продуктивности лесной растительности происходит заметное снижение 
накопленных запасов (пулов) органического вещества почв (ОрВП). Результаты 
моделирования позволили оценить количественные параметры потери ОрВП. Хотя 
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суммарный пул углерода в экосистемах возрастает за счет биомассы древостоя, мы 
можем заключить, что сработка ОрВП отражает снижение устойчивости лесных 
экосистем. 
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Рис. 4. Влияние потепления климата и поступление атмосферного азота во второй 

половине ХХ века на повышение продуктивности леса (% к сценарию без изменения 
природной среды) на 22 пробных площадях по трансекте от северной Финляндии 

(справа) до южной Германии (слева) 
 

 
Рис. 5. Изменение пула ОрВП в лесных почвах по трансекте от северной Скандинавии 
до южной Германии при антропогенном увеличении поступления азота из атмосферы 
(N), потеплении климата (Т) и при совместном воздействии этих факторов (Sum) по 

данным модели EFIMOD. 
 

4.1.2. Роль пожаров и изменения климата в лесах Цетральной 
Канады. 

В канадских таежных (бореальных) лесах частота верховых пожаров, заметно 
возросла в течение трех последних десятилетий – тенденция, которую канадские 
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экологи объясняют потеплением климата, хотя за этот же период сильно возрасла и 
освоенность канадских лесов, что также может сильно влиять на частоту пожаров. Это 
привело к заметным изменениям баланса углерода в лесах в масштабе всей страны 
(Kurz, Apps, 1999). Сценарии для ожидаемого изменения климата в северных лесах 
предсказывают более теплые и в ряде случаев более сухие климатические условия по 
сравнению с существующими, а также изменение режима естественных нарушений. 
Ранее подчеркивалось, что лесные пожары и инвазии насекомых в историческом 
аспекте были чувствительны к варьированию погодных условий (Wotton et al., 1998).  

 
Таблица 1. Суммарный запас древесины (м3/га) за 150 лет имитации (2 ротации в 
режиме сполошных рубок без нарушений) с разными сценариями изменения климата 

Климатические Сосна Банкса Черная ель 
сценарии Запас % изменений Запас % изменений 

Постоянный 242 0 366 0 
CGCM A2 280 16 439 20 
CGCM B2 273 13 429 17 
CSIRO A2 282 17 455 24 
CSIRO B2 278 15 450 23 

HADCM A2 258 7 397 8 
HADCM B2 256 6 394 8 

 
Таблица 2. Баланс углерода (нетто экосистемная продуктивность) за 150 лет имитации 
(кг[С]/м2 в год). Все климатические сценарии A2.  
Породы 

 
Климатически
е сценарии 

Рубки 
 

2 
пожара 

4 
пожара 

Рубка-
пожар 

Пожар
-рубка 

Инвазия 
вредителей 

Сосна Постоянный 0.005 0.007 -0.007 0.011 0.003 0.006 
Банкса CGCM 0.004 0.009 -0.005 0.012 0.002 0.004 
 CSIRO 0.003 0.008 -0.005 0.011 0.002 0.004 
 HADCM 0.005 0.008 -0.006 0.011 0.003 0.005 
        
Черная  Постоянный 0.003 -0.005 -0.032 0.006 -0.001 0.005 
ель CGCM -0.004 -0.003 -0.029 0.005 -0.005 -0.004 
 CSIRO -0.006 -0.003 -0.028 0.004 -0.009 -0.005 
 HADCM -0.002 -0.003 -0.030 0.005 -0.006 0.001 
 

Для выяснения прямого влияния потепления с небольшим снижением осадков 
была проведена долговременная имитация лесных экосистем моделью EFIMOD с 
опредлением, нетто биологической продуктивности (НБП), динамику ОрВП и эмиссии 
углекислого газа («дыхание почвы», гетеротрофное дыхание, ГД) и на общий 
экосистемный бюджет углерода (нетто экосистемную продуктивность, НЭП) в таежных  
лесах Центральной Канады (Моделирование динамики…, 2007; Bhatti et al., 
2009;.Chertov et al., 2009; Simard, 2010). Были использованы три глобальных модели 
циркуляции атмосферы (ГМЦА): Канадского климатического центра CGCM2, Хадли 
центра в Великобритании  HadCM3 и астралийскую модель CSIRO Mark 2.  Для каждой 
ГМЦА использовались два сценария по эмиссии углекислого газа: А2 в случае 
снижения эмиссий и В2 при сохранении высоких значений техногенных эмиссий за 
период 1901-2100 гг. Имитация проводилась для двух широко распространенных в 
центральной Канаде древесных пород: сосны Банкса (jack pine, Pinus banksiana Lamb.) 
и черной ели (black spruce, Picea mariana [Miller]) за 150-летний период с двумя 
оборотами рубки. Прогоны модели осуществлялись по 7 климатическим сценариям 
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(табл. 1) и 7 режимам нарушений (естественное развитие в течение 150 лет; 2 рубки в 
70 и 145 лет, 2 пожара в 70 и 145 лет; 4 пожара в 32, 70, 107 и 145 лет; рубка в 70 и 
пожар в 145 лет; пожар в 70 и рубка в 145 лет; насекомые-вредители в 70 и рубка в 145 
лет.  

Результаты этой работы показали, что потепление климата в таежной зоне 
существенно повышает хозяйственную производительность насаждений (табл. 1), но 
при этом происходит снижение до 15% пула ОрВП в таежных почвах, что в 
экосистемах черной ели приводит к отрицательному балансу углерода (табл. 2, режим 
«Рубки»). 

Более выразительными являются данные по влиянию типичных для Канады 
верховых пожаров на леса сосны Банкса и черной ели. Эти пожары приводят к 
заметному снижению производительности лесов и потерями ОрВП, особенно 
значительным при частых пожарах. Это является следствием как прямого выгорания 
органических горизонтов почв, так и снижения посткпления опада из постардавиших 
древостоев. В то же время, баланс углерода не во всех случаях становится 
отрицательным, поскольку в Канаде горельники не вырубаются, а стволы оставляются 
на территории. В целом, верховые пожары оказывают значительно более сильное 
отрицательное влияние на баланс углерода в хвойных лесах Центральной Канады по 
сравнению с прямым положительным воздействием потепления климата на 
продуктивность лесов. На этом основании канадские экологи делают заключение о 
негативном влиянии изменения климата на таежные леса в связи с возрастанием 
частоты лесных пожаров при потеплении (Bhatti et al., 2009). 
 

4.1.3. Моделирование динамики углерода почвы при различных системах 
традиционного земледелия и лесопользования на территории Европейской 
России. 

Долговременную динамику углерода почвы (С) при различных антропогенных 
воздействиях оценивали для суглинистых дерново-подзолистых почв (Бобровский и 
др., 2009). Использовали систему моделей биологического круговорота углерода и 
азота в лесных экосистемах EFIMOD (Komarov et al., 2003) вместе со встроенной в нее 
почвенной моделью ROMUL (Chertov et al., 2001). Использование модели EFIMOD для 
оценки динамики С при традиционном природопользовании обусловлено тем, что в 
исторических системах земледелия лесная стадия является одним из обязательных 
элементов. Поэтому оценить вклад таких систем земледелия в общую динамику 
экосистемы и баланс элементов возможно только при условии использования модели, 
хорошо симулирующей динамику лесных экосистем. 

Для инициализации модели имитировали свободное развитие леса в 
стационарных климатических условиях до стабилизации уровня С почвы. Естественное 
возобновление древостоя моделировали путем «подсадки» каждые 15 лет 5-летних 
сеянцев основных видов деревьев – ели, липы, дуба, сосны, березы, осины с 
плотностью каждого вида 700 шт./га. Этап инициализации модели составил 370 лет; в 
итоге «сформировался» смешанный разновозрастный лес с доминированием 
позднесукцессионных видов деревьев. 

Далее моделировали свободное развитие леса и 4 типа сценариев антропогенных 
воздействий.  

(1) Подсечно-огневое земледелие (SB) с разной частотой воздействий. Цикл: 
посев на росчистях 3 года, периоды между расчистками 20, 40, 60, 80 и 120 лет.  

(2) Переложное земледелие (ShS). Циклы: 10, 20 лет пашни и 10, 20 лет развития 
леса.  

 37



(3) Паровая система земледелия в виде трехполья. Без внесения удобрения (TFF) и 
с внесением удобрения (TF) один раз в 3, 9 и 18 лет.  

(4) Рубки сплошные и выборочные. Сплошные рубки (СС) с оборотом 10, 20 лет 
(дровяные леса) и 40, 60, 80, 120 лет (строевые леса). Принудительно-выборочные 
рубки (SC) с изъятием древесины один раз в 30 лет в объеме 30% древесины по запасу 
«сверху».  

В разработанных «земледельческих» сценариях использовали посев озимых и 
яровых культур с разделением на надземные и подземные когорты опада и 
определенным временем их поступления на/в почву. Для сравнения результатов 
продолжали также моделировать «свободное развитие леса» (сценарий F). Всего было 
симулировано 22 сценария природопользования на срок 260 лет с шагом 
моделирования 1 год.  

 

 
Рис. 6. Динамика углерода почвы после начала антропогенных воздействий: А – 

сценарии рубок и свободного развития леса; Б – сценарии подсечно-огневого 
земледелия; В – сценарии трехполья; Г – сценарии перелога. Обозначения сценариев в 
тексте 

 
Результаты моделирования показали, что максимальный уровень содержания С 

сохраняется при свободном развитии лесной экосистемы (рис. 6, А, сценарий F). 
Средний за период воздействий запас С в почве уменьшается в ряду: (а) свободное 
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развитие леса – (б) строевой лес – (в) дровяной лес, выборочные рубки, трехполье с 
удобрением раз в три года – (г) подсека с оборотом 40–120 лет, трехполье с удобрением 
раз в 9 и 18 лет – (д) подсека с оборотом 20 лет – (е) все варианты перелога и трехполье 
без удобрения (рис. 7).  

При оборотах рубки (рис. 6, А) от 40 до120 лет (строевые леса) наблюдали 
снижение содержания С относительно «фоновой» лесной почвы при отсутствии 
заметного «накопления потерь». Хорошо заметно отличие динамики С почвы для 
дровяных лесов (сплошная рубка с оборотом 10 и 20 лет) по сравнению со строевыми 
лесами: с течением времени происходит уменьшение содержания С «с накоплением 
потерь». Малый оборот рубки деревьев ведет к большим потерям С почвы, поскольку в 
молодом состоянии деревья тратят больше питательных веществ, чем отчуждают с 
опадом. Так, период наибольшего прироста органического вещества и потребления 
наибольшего количества элементов питания наблюдается в дубняках в возрасте около 
25 лет, осинниках – около 30 лет, сосняках – 30–50 лет (Ремезов, 1961). Сценарий 
принудительно-выборочных рубок (SC30) показал динамику С почвы, близкую к его 
динамике в дровяных лесах. 

 

 
Рис. 7. Средняя масса углерода почвы при разных сценариях природопользования 

за 260-летний период моделирования. Черта над столбцом показывает ошибку 
среднего. Обозначения сценариев в тексте 

 
Подсечно-огневую систему земледелия на территории центра европейской России 

применяли на протяжении более 4000 лет (История…, 1985). При этом еще в 19 – 
начале 20 века в России подсеку как крестьяне, так и специалисты в сельском хозяйстве 
рассматривали как более выгодную альтернативу навозной пашне (Милов, 1998). 
Эффективность подсеки зависит от уровня восстановления почвенного плодородия во 
время «отдыха» – свободного развития леса, что демонстрируют и результаты 
моделирования (рис. 6, Б, рис. 7). При большой длительности лесной фазы (сценарий 
SB120) уровень содержания С в почве сравним с трехпольем (сценарий TF9). При всех 
вариантах подсеки наблюдается ступенчатое уменьшение содержания С в почве, при 
этом содержание С падает непропорционально уменьшению периода отдыха. При 
сценариях SB10 и SB20 содержание С уменьшается как на сельскохозяйственной, так и 

 39



на лесной фазе, при SB40 и SB60 наблюдается стабилизация содержания С на лесной 
фазе, при SB80 и SB120 – частичная компенсация содержания С на лесной фазе. 

Для территории России нет массовых количественных данных по варьированию 
сроков отдыха и урожайности при подсеке, но они есть для Финляндии. За два века в 
Финляндии оборот рубки при подсеке сократился с 40 до 25 лет, а урожайность 
зерновых на лесных полях уменьшилась в два раза (История…, 1985). 

Некоторые исследователи относят подсечно-огневое земледелие к «естественным 
экзогенным» нарушениям (Attiwill, 1994), мотивируя это тем, что после таких 
нарушений происходит восстановление «первичных лесов». Наши результаты 
показывают, что даже 120 лет спонтанного развития в рассматриваемых условиях не 
хватает для восстановления органического вещества почвы. В историческое время срок 
спонтанного развития леса при подсеке составлял 25–80 лет (История…, 1985; Милов, 
1998). 

Трехполье считают крупнейшим достижением европейской агрикультуры 
средневековья. Появление и распространение трехполья в Европе относят к 11 в. 
Трехполье поставило урожайность в прямую зависимость от качества обработки и 
удобрения земли, которое служило главным фактором поддержания почвенного 
плодородия. Результаты моделирования показывают, что при трехполье (рис. 6, В, рис. 
7) содержание С в почве зависит от качества (частоты) удобрения. При этом внесение 
навоза или компоста дает позитивный, но кратковременный эффект (Debosz et al., 
2002).  

Сценарий TF3 близок к представлению об идеальной системе «органического 
земледелия». На территории России такую систему применяли только на отдельных 
полях для выращивания специальных культур (например, конопли) и в огородном 
хозяйстве. По расчетам, для нормального удобрения соотношение площадей пашен и 
лугов должно составлять 1:1,24 (Милов, 1998). В действительности такое соотношение 
в центральной России в историческое время не достигалось. Например, в конце 18 века 
площади сенокосов были ниже расчетной нормы в Московской губернии в 4,9 раз; 
Псковской – 8,2; Смоленской – 10,4; Ярославской – 6,3; Костромской – 6,1; Калужской 
– 10,0; Тульской – 11,4 раз (там же, С. 216). По данным источников 17–19 веков, навоз 
на пашни вносился нерегулярно, в среднем один раз в 7–12 лет. При этом речь идет о 
полях, ближних к поселениям, дальние поля не унавоживались вовсе (Милов, 1998; 
Бобровский, 2004). Таким образом, сценарий TF9 соответствует режиму 
землепользования в богатых помещичьих и монастырских хозяйствах. Сценарий TF18 
имитирует уровень агрикультуры хозяйства бедного, но использующего удобрение.  

Время «потери силы» землей при отсутствии удобрения по источникам 18 века 
оценивалось в 10 – 30 лет (Милов, 1998). Это демонстрирует сценарий TF. При 
распашке именно в первые годы все почвы теряют до 20-40% общего содержания 
гумуса, затем темпы минерализации снижаются (Перепелица, 1974; Золотарева и др., 
1988).  

Переложная система земледелия была компромиссным средством поддержания 
почвенного плодородия при отсутствии возможности как нормального удобрения, так и 
длительного развития леса для восстановления почвы. Как и в случае подсеки, скорость 
уменьшения содержания гумуса зависит от времени свободного развития леса (рис.6, 
Г).  

Результаты моделирования показали слабые различия в характере динамики С 
почвы при разных сценариях переложного земледелия (рис. 7). В целом перелог 
характеризуется быстрым падением содержания С в почве, которое не компенсируется 
в промежутки свободного развития леса. При уменьшении времени ротации 
наблюдается более резкое падение содержания С как на полевой, так и на лесной фазах 
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перелога. Широкое использование лесного перелога на территории Европейской 
России в 15–19 вв. могло быть более эффективным скорее для получения 
дополнительной дровяной древесины, чем для значимого улучшения качества пашни. 
 

4.2. Применение модели EFIMOD на уровне лесного массива (лесного 
участка, ландшафта, региона). 
Применение модели для больших лесных территории осуществлялось с ее 

повыдельными прогонами, генерализацией полученных результатов и 
картографическим выводом данных. 

 
4.2.1. Экологические и лесоводственные аспекты различных режимов 
лесного хозяйства на примере лесничества «Русский лес». 

Объектом моделирования был выбран участок лесничества «Русский Лес» 100 
км к югу от Москвы на левых террасах р. Оки с подзолистыми супесчаными и 
песчаными почвами (типы лесорастительных условий А2 и В2). Этот лесной массив 
характеризуется преобладанием средневозрастных смешанных насаждений как 
результат чрезмерно интенсивных рубок в течение всего ХХ века. Участок имеет 
площадь 300 га со 108 выделами. Моделировалось 4 режима хозяйства: А – заповедный 
режим без рубок и катастрофических нарушений, Б – выборочное хозяйство с двумя 
рубками ухода и последующей выборочной рубкой каждые 30 лет по 30% запаса; В – 
нормативное сплошнолесосечное хозяйство с 4-мя рубками ухода, сплошной рубкой со 
сжиганием порубочных остатков и успешным возобновлением хвойными породами; Г - 
сплошнолесосечное хозяйство с двумя верховыми уходами, укороченным оборотом 
рубки, сжиганием порубочных остатков и возобновлением преимущественно 
лиственными продами («рубки дохода» без соблюдения правил рубок). 
Моделировалось 200-летняя динамика древостоев и почв с указанными режимами 
лесного хозяйства. 

 
Рис. 8. Динамика пулов углерода ОрВП за 200.летний период имитации при разных 
режимах лесопользования  (Моделирование динамики…, 2007). А – заповедный режим; 
Б – выборочное хозяйство; В – сплошнолесосечное хозяйство; Г – режим нарушений 
правил рубок. 
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Рис. 9. Динамика углерода биомассы древостоев за 200-летний период имитации при 

разных режимах лесопользования  (Моделирование динамики…, 2007) 
 

 

 
Рис. 10. Бюджет углерода (как разница между НБП и суммой всех потерь углерода) по 

данным имитации на всю территорию по всем режимам лесопользования; 
см.обозначения на рис. 6 (Моделирование динамики…, 2007) 

 
Обобщенные результаты представлены на Рис. 8, 9 и в табл. 3, а более подробно 

это изложено в монографии «Моделирование динамики органического вещества в 
лесных экосистемах» (2007). Вековые изменения почв (рис. 8) позволяют 
предположить, что эти леса были в прошлом сильно нарушены, т.к. наблюдается 
значительный рост запасов ОрВП в почве при режиме А (естественное развитие). При 
нормативном хозяйстве почвенный покров остается в состоянии динамического 
равновесия. Однако, при нарушении режима хозяйства наблюдается заметное снижение 
запасов ОрВП в лесных почвах. Результаты имитации биомассы древостоев фактически 
повторяют динамические тренды изменений почв: при естественном развитии идет 
последовательное накопление биомассы, тогда как при режиме Г наблюдаются самые 
низкие значения углерода биомассы древостоев. Следует подчеркнуть, что 

 42



последовательное возрастание запасов ОрВП и биомассы при естественногм развитии 
происходит до определенного уровня, после которого почва стабилизируется, а 
биомасса деревьев в абсолютно-разновозрастных «коренных, климаксовых» древостоях 
будет ниже таковой в одновозрастных насаждениях (Разумовский, 1981). Однако это 
еще не наблюдается в течение 200-летнего периода. 

Полученные данные при моделировании лесной территории показывают 
сильные различия статей баланса углерода при разных режимах лесопользования (Рис. 
10). Если нормативное сполошнолесосечное лесопользование имеет нулевой баланс, то 
при естественном развитии и выборочных рубках баланс положительный, а при 
«рубках дохода» отрицательный.  

Приведенные выше различия экологических и хозяйственных характеристик 
различных режимов лесопользования отражают несколько идеализированную картину, 
поскольку предполагают полную идентичность лесного хозяйства на всей 
моделируемой территории. Однако, в реальности чаще всего встречается комбинация 
различных режимов в зависимости от экономической дотупности лесов и местных 
экономических и социальных условий. Наиболее доступные леса эксплуатируются 
интенсивнее, вплоть до «рубок дохода», удаленные могут даже оставаться резервными 
или заповедными.  

Для выяснения баланса углерода и производительности леса за 200-летний 
период при разной площади четырех режимов лесопользования были сделаны 
специальные прогоны модели, используя данные моделирования для всей территории. 
Были приняты следующие допущения: 1) предполагалось, что структура территории в 
отношении лесорастительных условий, возраста и состава древостоев на участках с 
разными режимами всегда одинакова; 2) за некий образец «рубок дохода» принимался 
режим нарушений в базовом сценарии или плантационного лесовыращивания с 
коротким оборотом рубки и отрицательным балансом углерода. Было просчитано 8 
вариантов сочетаний различных режимов от сплошнолесосечного режима до режима с 
доминированием выборочного хозяйства и заповедной территории (6 комбинаций) 
плюс два режима с 30% «рубок дохода», но в сочетании со сплошнолесосечным или 
выборочным хозяйством. Результаты, отраженные в табл. 3, оказались чрезвычайно 
интересными. Во-первых, 10% территории с заповедными лесами заметно увеличивал 
положительный баланс углерода во всех сочетаниях режимов. Во-вторых, увеличение 
депонирования углерода и продуктивность территории (углерод вырубленной 
древесины) заметно возрастал пи увеличении территории с выборочным хозяйством. В-
третьих, самым оптимальным и по балансу гулерода, и по продуктивности оказался 
последний режим с 20% заповедных лесов, 50% выборочного хозяйства и даже с 30% 
«рубок дохода».  
 
Таблица 3. Статьи бюджета углерода, средние величины за 200-летнюю имитацию на 
всей территории лесного массива с различной комбинацией режимов лесопользования 
(потери углерода при сжигании порубочных остатков в таблице не представлены) 
 

Углерод
НБП* 

 
 
 

Углерод 
эмиссии 

углекисого 
газа из 
почвы 

 

Углерод 
выруб-
ленной 
древе-
сины 

 

Баланс 
углеро- 
да** 

 
 

Углерод 
древо- 
стоя 

 
 

Угле-
род 
ОрВП 

 
 

Пропорция режимов, % 
площади:  
заповедный 

режим/выборочное 
хозяйство/сплош-

нолесосечное хоз-во/ 
«рубки дохода»  Тонн [C] / га в год Тонн [C] / га 
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0 / 0 / 100 / 0 4.75 3.48 0.81 0 38 36 

10 / 0 / 90 / 0 4.91 3.67 0.73 0.099 45 41 

10 / 0 / 80 / 10 4.85 3.61 0.76 0.074 44 44 

10 / 20 / 60 / 10 5.01 3.75 0.84 0.112 45 43 

10 / 40 / 40 / 10 5.17 3.89 0.91 0.150 46 45 

10 / 60 / 20 / 10 5.33 4.03 0.99 0.188 48 47 

20 / 0 / 50 / 30 4.89 3.69 0.75 0.123 48 45 

20 / 50 / 0 / 30 4.46 4.03 0.94 0.218 51 51 

*    НБП,  нетто биологическая продуктивность;  
** Нетто экосистемная продуктивность,НЭП,  как разница между НБП и потерями углерода (эмиссия 
углекислоты плюс углерод древесины)  

 
4.2.2. Экологические и лесоводственные аспекты освоения лесного 
масива «Гришкинская дача» Лисинского учебно-опытного 
лесничества. 

Приведенный выше пример использования модели EFIMOD в лесничестве 
«Русский лес» отображает динамику лесных экосистем в освоенных интенсивно 
эксплуатируемых лесах при разных режимах лесопользования. Напротив, Гришкинская 
дача Лисинского учебно-опытного лесничества представляет собою леса научного 
значения, в которых последние десятилетия ведется очень ограниченное 
лесопользование. 

 

 
 

Рис. 11. Динамика углерода биомассы древостоев Гришкинской дачи в сценариях 
естественного развития и сплошнолесосечного хозяйства 

 
Площадь этого массива 1200 га, где 67% территории составляют спелые и 
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перестойные высокопродуктивные леса, в которых половина древостоев старше 120 
лет. Для этого лесного массива было сделано два 100-летних сценария для прогонов 
модели: а) естественное развитие леса без катастрофических нарушений и б) 
нормативный сплошнолесосечный режим с 4-мя рубками ухода и сплошной рубкой в 
100-120 лет в хвойных и 60-80 лет в лиственных насаждениях. Рубки имитировались 
каждые 10 лет с соблюдением расчетной лесосеки и успешным возобновлением 
хвойных и лиственных пород. В среднем «вырубалось» 3.8 м3/га в год за 100-летний 
период. 

Генерализованные результаты этой имитации приведены на рис. 11-13. 
Обращает на себя внимание принципиальное различие динамических трендов при 
есественном развитии и вовлечении лесов в рубки – как для древостоев, так и для 
почвы (рис. 11 и 12). Если при естественном развитии продолжается последовательная 
аккумуляция углерода в древостоях, то при рубках идет столь же последовательное 
снижение общей биомассы лесного массива за счет смены старых насаждений 
молодняками. В итоге средние величины углерода биомассы деревьев на всей 
территории в конце имитации составляют при естественном развитии 163 т/га, а при 
рубках 39 т/га. В почвах при естественном развитии отмечается заметное возрастание 
массы ОрВП до достижения равновесного состояния. Напротив, при вовлечении лесов 
в рубки прослеживается некоторое снижение пулов ОрВП к концу 100-летней 
имитации. 

 

 
 

Рис. 12. Динамика углерода ОрВП Гришкинской дачи в сценариях естественного 
развития и сплошнолесосечного хозяйства 

 
На рис. 13 хорошо видны существенные различия статей баланса углерода в 

обоих сценариях. И нетто биологическая продуктивность (НБП), и дыхание почвы 
(эмиссия углекислоты) снижаются в среднем на всей территории при рубках. При этом 
при рубках происходит изъятие из лесных экосистем заметного количества углерода с 
заготовленной древесиной и сжиганием порубочных остатков. Это приводит к 
существенному различию баланса углерода всей территории при естественном 
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развитии и рубках. В режиме заповедания на территории наблюдается существенное 
депонирование углерода в размере 0.73 т С /га в год, то при освоении лесов в рубки 
идут потери углерода в количестве 0.83 т С /га в год.  

В принципе, такая картина изменения лесной территории и статей баланса 
углерода при освоении лесов логически легко предсказуема. Однако, результаты 
применения математического моделирования позволили количественно оценить 
экологические аспекты «освоения лесов», т.е. перевода их из более-менее 
естественного состояния в «хозяйственные леса». 

 

 
 
Рис 13. Компоненты баланса углерода в лесных экосистемах Гришкинской дачи, 

средние значения за 100-летний период. Статья «заготовленная древесина» включает в 
себя также и потери углерода при сжигании порубочных остатков 

 
4.2.3. Повыдельное моделирование динамики лесных эксистем 
Республики Коми при изменениях климата. 

В данной работе оценивалось влияние изменений климата и, как следствие, 
возрастающей частоты лесных пожаров, на динамику ключевых показателе лесных 
экосистем в Республике Коми. В качестве модельных объектов были выбраны лесные 
заказники «Белый» и «Ляльский». 

Начальные значения запасов ОрВП и азота, использованные для параметризации 
модели, приведены в таблице 4. 

Для параметризации модели подмодели ROMUL использовались описания 
почвенных разрезов, любезно предоставленные К.С.Бобковой (неопубл.), а также 
данные, приведенные в монографиях (Биопродукционный процесс … , 2001; Коренные 
еловые леса … , 2006). 

 
Таблица 4. Начальные значения запасов органического вещества почвы и азота (в 
кг/м2), использованные для параметризации подмодели ROMUL, в зависимости от типа 
лесорастительных условий и доминанта древостоя. 
Тип леса Доминант 

древостоя 
Подстилка Азот в 

подстилке 
Лабильный 

гумус 
Азот в 

лабильном 
гумусе 

Гумус Азот в 
гумусе
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Бруснич. Береза 1.89 0.031 0.21 0.0034 6.40 0.28
Бруснич. Сосна 1.37 0.022 0.74 0.012 6.40 0.28
Бруснич. Ель 1.47 0.024 0.63 0.010 6.40 0.28
Долгомош. Береза 4.51 0.12 0.50 0.013 6.96 0.45
Долгомош. Сосна 3.26 0.086 1.75 0.046 6.96 0.45
Долгомош. Ель 3.51 0.093 1.50 0.040 6.96 0.45
Кислич. Осина 0.91 0.022 0.11 0.0024 10.30 0.57
Кислич. Береза 0.91 0.022 0.11 0.0024 10.30 0.57
Кислич. Сосна 0.66 0.016 0.35 0.0084 10.30 0.57
Кислич. Ель 0.71 0.017 0.31 0.0072 10.30 0.57
Лишайн. Сосна 0.45 0.0088 0.24 0.0047 3.84 0.21
Ос.-сфагн. Береза 5.63 0.099 0.63 0.011 8.28 0.35
Ос.-сфагн. Сосна 4.06 0.071 2.19 0.038 8.28 0.35
Ос.-сфагн. Ель 4.38 0.077 1.88 0.033 8.28 0.35
Сфагн. Береза 5.63 0.099 0.63 0.011 8.28 0.35
Сфагн. Сосна 4.06 0.071 2.19 0.038 8.28 0.35
Сфагн. Ель 4.38 0.077 1.88 0.033 8.28 0.35
Тр.-сфагн. Береза 5.63 0.099 0.63 0.011 8.28 0.35
Тр.-сфагн. Сосна 4.06 0.071 2.19 0.038 8.28 0.35
Тр.-сфагн. Ель 4.38 0.077 1.88 0.033 8.28 0.35
Чернич. Осина 2.66 0.038 0.29 0.0042 9.32 0.53
Чернич. Береза 2.66 0.038 0.29 0.0042 9.32 0.53
Чернич. Сосна 1.92 0.027 1.03 0.015 9.32 0.53
Чернич. Ель 2.068 0.029 0.89 0.012 9.32 0.53
 

В качестве исходных данных использовались повыдельные материалы 
лесоустройства, объединенные в базу данных. В таких базах приводятся как данные, 
характеризующие выдел в целом, так и данные по отдельным элементам леса. Под 
элементами леса понимаются одновозрастные когорты деревьев одного вида, 
характеризующиеся сходными параметрами: возрастом, средней высотой и средним 
диаметром на уровне груди. 

Лесоустроительными данными, характеризующими выдел в целом, являются: 
формула, доминант и относительная полнота древостоя, запас выдела, класс бонитета и 
тип лесорастительных условий (Chertov et al., 2006). 

К характеристикам отдельных элементов леса относятся: возраст, средняя 
высота и средний диаметр на высоте груди, число деревьев на 1 гектар. 

Для работы модели необходимы следующие входные параметры: видовой состав 
древостоя на участке, средняя высота деревьев, средний диаметр ствола на уровне 
груди, число деревьев на гектар, их возраст, характеристики пулов органического 
вещества почвы (Komarov et al., 2003). 

Обычно большая часть этой информации имеется в лесоустроительных базах 
данных. Однако некоторые параметры, необходимые для инициализации модели, в 
таких базах отсутствуют. Например, высота, диаметр на уровне груди и возраст 
приведены только для преобладающей породы. Количество деревьев на 1 га в 
лесоустроительных базах, как правило, вообще не указывается, также как и 
информация о почвенных пулах углерода. Информация о запасе сухостоя и валежа 
является, как правило, крайне неполной. 

Отсутствующие данные могут быть легко вычислены на основе имеющихся 
(запас выдела, площадь выдела, полнота, формула древостоя, класс бонитета, вид 
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дерева). Авторами была разработана методика приведения информации, хранящейся в 
лесоустроительных базах данных, к форме, в которой она может использоваться в 
качестве входных данных для системы моделей EFIMOD. 

Согласно этой методике, над исходными данными производятся следующие 
операции: 

а) Запас древостоя на выделе пересчитывается в запас на 1 га, посредством 
деления общего запаса на площадь выдела. 

б) Рассчитывается запас для каждого вида деревьев, посредством умножения 
запаса на 1 га на коэффициент состава данного вида. 

в) Аналогичным образом рассчитывается относительная полнота каждой 
породы. 

г) Запас каждого вида пересчитывается на теоретический (т.е. такой запас, 
который имел бы этот вид в одновидовом древостое с относительной полнотой 
древостоя, равной 1.0), для чего запас вида был поделен на его фактическую полноту. 

д) Исходя из таких данных, как вид дерева, запас породы и класс бонитета, по 
таблицам хода роста определяются возраст, средняя высота и средний диаметр, 
количество деревьев на 1 га по региональным таблицам хода роста нормальных 
насаждений. 

е) Также для параметризации модели необходимо указать стандартные 
квадратические отклонения для высоты и диаметра. При таксации они не 
определяются, но могут быть косвенно оценены по следующему эмпирическому 
правилу (Лесотаксационный справочник, 1980): среднее дерево насаждения по высоте 
составляет 1.2 высоты самого низкого или 0.6 высоты самого высокого дерева. 
Стандартное квадратическое отклонение среднего диаметра насаждения может быть 
оценено по правилу: среднее дерево насаждения по диаметру составляет 2 диаметра 
самого тонкого или 0,6 диаметра самого толстого дерева. 

Для оценки влияния типа ведения лесного хозяйства на лесные экосистемы были 
подготовлены два имитационных сценария. Следует отметить, что в данных сценариях 
не учитывается воздействие на лесные экосистемы ряда катастрофических факторов 
(ветровалы, вспышки численности фитопатогенов). 

Сценарий NAT_. Этот сценарий имитирует естественное развитие леса при 
отсутствии внешних воздействий. Естественное возобновление имитируется из расчета 
1000 деревьев на гектар и происходит каждые 15 лет. 

Сценарий FIR_. Данный сценарий предполагает развитие экосистемы без 
рубок, но с учетом возможных лесных пожаров. Частота пожаров имитировалась с 
учетом ежегодных данных по территориям, подвергающимся лесным пожарам. 
Имитировалась следующая интенсивность пожаров (% сгорания соответствующего 
пула углерода): листва – 10%, ветви – 5%, стволы – 5%, тонкие корни – 25%, лесная 
подстилка – 100%, органические горизонты почвы – 25% (в соответствии с Kurz, Apps, 
1999), с 25-процентным варьированием этих параметров. При этом предполагается, что 
несгоревшие части деревьев остаются на участке и далее вовлекаются в процесс 
разложения. 

Видовой состав возобновления определялся на основе типа леса по Сукачеву и 
доминанта древостоя на основе данных К.С.Бобковой по видовому составу 
возобновления (Биопродукционный процесс … , 2001; Коренные еловые леса … , 2006) 
и экспертных оценок. 

Для создания имитационных сценариев, учитывающих предполагаемые 
изменения климата, были использованы ряды температуры воздуха и атмосферных 
осадков за XX в., интерполированных в узлы сетки 0,5ºx0,5º (CRU TS 2.0), и сценарии 
изменений глобального климата в XXI в. (TYN SC 2.0), рассчитанные для той же сетки 
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(Mitchell et. al., 2004).  
Был использован наиболее «экстремальный» вариант потепления, основанный 

на сценарии эмиссии парниковых газов A1Fi и модели общей циркуляции атмосферы 
HadCM3, чтобы продемонстрировать максимальный диапазон возможных 
климатических условий. Для оценки максимально возможного диапазона изменений в 
параметрах экосистем в течение XXI века использовались 2 климатических сценария: 
«экстремальное изменение климата» (_C) и «стационарный климат» (_S). 

В качестве «экстремального» сценария (_С) для 2001–2100 использован 
сценарий из TYN SC 2.0, основанный на модели HadCM3 и сценарии эмиссии 
парниковых газов A1Fi. В соответствии с этим сценарием, температура воздуха до 
конца XXI века должна вырасти на 7.2ºC. Изменение осадков не столь существенно, 
годовая сумма увеличивается на 8%, главным образом, за счет роста осадков в зимние 
месяцы. Можно дискутировать о том, насколько правдоподобно такое повышение 
температуры и какой из сценариев изменения климата лучше, но в рамках данной 
работы был важен не точный количественный прогноз, а качественное поведение 
экосистемы при изменении климата, влияние потепления на основные потоки углерода. 

«Стационарный» сценарий (_S) был получен в предположении, что в течение 
XXI века сохранятся климатические условия второй половины 20 века. Основные 
характеристики климатических сценариев для разных объектов приведены в таблице 5. 

 
Таблица 5. Климатические данные для узла сетки с координатами 62º45′с.ш., 51º45′в.д. 
(Железнодорожное лесничество) за период 1961–1990 гг., и предполагаемые на конец 
XXI столетия в соответствии с «экстремальным» сценарием изменения климата 
(модель глобальной циркуляции HadCM3 и сценарий эмиссии A1Fi) (Mitchell et al., 
2004) 
  I II III IV V VI VII VIII IX X XI XII Год

  Средние значения за 1961–1990 гг. 

Температура воздуха, ºC -17.5 -14.6 -7 -0.1 7 13.3 16.8 13.3 7.6 -0.1 -7.2 -13.1 -0.1

Осадки, мм 36 27 28 35 45 59 75 67 60 61 50 43 585

  Предполагаемые средние для 2071–2100 гг. 

Температура воздуха, ºC -6.2 -7.6 -1.5 4.8 13.6 18.8 24.5 19.9 14.4 6.4 1.5 -0.9 7.3

изменение, ºC 11.3 7.0 5.5 4.9 6.6 5.5 7.7 6.6 6.8 6.5 8.7 12.2 7.4

Осадки, мм 59 35 29 43 54 77 81 67 66 73 70 66 720

изменение, мм 23 8 1 8 9 18 6 0 6 13 20 23 135

изменение,% 63% 29% 5% 23% 21% 31% 8% -1% 10% 21% 40% 55% 23%
 

В сценарии NAT_S (без воздействий, стационарный климат) запас углерода в 
древостое постоянно увеличивается, достигая к концу периода моделирования 
значений порядка 70 т[C]/га для всех изучаемых территорий. Рассчитанный 
доверительный интервал для данного параметра составил, в среднем, порядка 6.1%. 
Рост данного показателя обусловлен накоплением углерода в биомассе деревьев в ходе 
их роста, и он более заметен в случае заказника «Ляльский», для которого характерна 
более высокая, чем у заказника «Белый», доля молодых и средневозрастных древостоев 
и, соответственно, более высокий потенциал к аккумуляции углерода в фитомассе. 

В случае же изменений климата (сценарий NAT_C), которые выражаются в 
повышении среднемесячных температур и увеличении количества осадков, накопление 
углерода в древостое идет более интенсивно, достигая, в конечном итоге, значений 
порядка 80 т[C]/га. 

Спрогнозированное при помощи модели увеличение скорости прироста 
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древесной растительности при изменениях климата (примерно на 1.6% в десятилетие) 
хорошо согласуется с данными, приводимыми в работе (Lopatin et al., 2006). При этом в 
обоих случаях (и при стационарном климате, и в условиях потепления) наблюдаются 
колебания данного показателя, связанные со сменой поколений деревьев и/или сменой 
видового состава древостоев. 

Запас углерода в почве для территории заказника «Белый» в сценарии NAT_S 
увеличивается с 50 до 56 т[C]/га. Накопление углерода в почвенном пуле можно 
объяснить увеличением потока опада по мере роста и развития древостоев в отсутствии 
нарушений. Для территории заказника «Ляльский», где преобладают относительно 
богатые органическим веществом типы почв и более влажные местообитания, процесс 
накопления углерода в пуле органического вещества почвы протекает медленнее и 
практически стабилизируется ко второй половине периода моделирования на уровне 82 
т[C]/га. Доверительный интервал, рассчитанный для данного значения, составил в 
среднем порядка 3.7%. 

Отметим, что запас углерода в почве здесь и далее рассматривается как сумма 
запасов в лесной подстилке и в минеральной части почвы. При этом стоит отметить, 
что на всех моделируемых территориях происходит небольшой рост доли подстилки в 
общем запасе органического вещества почвы и, соответственно, снижение доли гумуса, 
однако абсолютные запасы органического вещества в обоих пулах возрастают. 
Очевидно, что отсутствие рубок обеспечивает постоянный поток внутри- и 
напочвенного опада, вовлекающегося в процессы декомпозиции. При отсутствии 
антропогенных нарушений опад проходит все стадии разложения и формирует мощный 
пул стабильного гумуса. 

Сухостой и валеж, вкупе с ветровально-почвенными комплексами (ВПК) 
формируют множество микроместообитаний, повышая гетерогенность среды и 
создавая, тем самым, новые экологические ниши (Восточноевропейские … , 1994). 
Кроме того, запас сухостоя и валежа обеспечивает питание для обширного комплекса 
организмов-деструкторов. Таким образом, наличие в лесной экосистеме данных 
категорий древесного отпада может выступать как показатель ее биоразнообразия. 

В текущей версии модели две категории крупного древесного отпада – сухостой 
и валеж – не различаются и имитируются как часть древесного отпада со сравнительно 
низкой скоростью минерализации (Тарасов, 2002; Пулы и потоки … , 2007) и, в 
конечном счете, поступления продуктов разложения в почву. Под сухостоем в 
представлении системы моделей EFIMOD понимается неразложившаяся часть 
древесного отпада (Михайлов, 2004). 

Поскольку в таксационных описаниях данные по запасу сухостоя и валежа, как 
правило, отсутствуют, начальные значения данного показателя, необходимые для 
параметризации модели, были оценены на основе данных по отпаду для нормальных 
древостоев (Швиденко и др., 2008). 

При сценарии без воздействий (NAT_S) происходит накопление углерода в пуле 
сухостоя и валежа в первой половине периода моделирования, связанное с процессами 
естественной гибели деревьев, и последующая стабилизация данного показателя на 
уровне 10-12 т[С]/га, со средним доверительным интервалом около 6.5%. Изменение 
климата (сценарий NAT_C) оказывает существенное влияние на запасание углерода в 
рассматриваемом пуле – стабилизация в данном случае происходит на уровне порядка 
8-9 т[С]/га. 

Если сравнивать реакцию различных пулов углерода в лесных экосистемах на 
два используемых в работе климатических сценария, можно отметить, что при 
изменении климата имеет место повышенное (по сравнению со стационарным 
климатом) накопление углерода в фитомассе. Запас углерода в сухостое, валеже и 
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почве при этом сценарии, наоборот, ниже, чем при стабильном климате. Доля 
подстилки в общем запаса органического вещества почвы при изменениях климата 
ниже. Это может объясняться тем, что увеличение среднемесячных температур, а также 
небольшое повышение количества осадков (и, соответственно, увеличение влажности 
подстилки и почвы) создает благоприятные условия для почвенной биоты и повышает 
скорость разложения органического вещества, причем, в большей степени, более 
лабильного пула подстилки. Эти процессы отражены в модели ROMUL (коэффициенты 
скоростей разложения органического вещества почвы, как было указано выше, зависят 
от температуры и влажности лесной подстилки и почвы). Следствием повышения 
интенсивности деструкционных процессов в почве является снижение запаса углерода 
в соответствующем пуле сухостоя и валежа. Другим следствием является увеличение 
количества азота почвы в форме, доступной для растений, что, в свою очередь, 
способствует росту продуктивности древостоев, поскольку данный фактор является 
лимитирующим в большинстве экосистем бореальных лесов (Федорец, Бахмет, 2003; 
Bobbink et al., 2010). Такое увеличение активности почвенных деструкторов и скорости 
минерализации было отмечено во многих исследованиях (например, Rustad et al., 2001; 
Vetter et al., 2005). Положительная связь между потеплением и увеличением 
продуктивности лесных экосистем в целом заметнее для лесов более холодных 
климатических зон (Strömgren, Linder, 2002). Другие аспекты влияния климата на 
продуктивность лесов обсуждаются в статье (Yurova et al., 2010). К сожалению, в силу 
ряда ограничений модель не может учитывать отрицательное влияние изменений 
климата на физиологические особенности растения – в частности, тепловой стресс, 
снижение количества фотосинтетически активной радиации вследствие увеличения 
облачности и реакцию на изменение гидрологического режима (Breshears et al., 2009; 
Johnston et al., 2009). Это обусловлено тем, что в данной системе моделей используется 
упрощенная модель продуктивности, достоинствами которой является небольшое 
количество необходимых для инициализации параметров и высокое быстродействие. 
Эта модель может быть легко заменена детальной экофизиологической моделью 
продуктивности. Однако здесь можно отметить, что изменение нормы осадков в 
данном случае невелико и, к тому же, носит положительный характер, а увеличение 
среднегодовых температур и снижение приходящей солнечной радиации, возможно, и 
оказывает влияние, но при моделировании на относительно малых временных 
промежутках, сопоставимых с продолжительностью жизни одного поколения деревьев, 
данным фактором можно пренебречь. Также система моделей EFIMOD не может 
имитировать эффект «фертилизации» за счет увеличения концентрации углекислого 
газа в атмосфере. Однако данный эффект для лесных экосистем бореального пояса пока 
остается под вопросом (Kurz et al., 2007), поскольку в ряде исследований (Percy et al., 
2002; Bond-Lamberty et al., 2007) никакого прироста продуктивности не отмечено. 

Поскольку территория заказника «Ляльский» представлена исключительно 
местообитания с избыточным увлажнением, развитие на ней пожара представляется 
крайне маловероятным. В связи с этим, сценарии, имитирующие лесные пожары 
(FIR_S и FIR_C) были применены только при моделировании динамики лесных 
экосистем на территории заказника «Белый». 

В сценарии FIR_S (с лесными пожарами при стационарном климате) также 
наблюдается увеличение запаса углерода в древостое, но данный прирост заметно 
меньше, чем в предыдущем сценарии – максимальная величина запаса достигает 
примерно 62 т[C]/га. Относительный прирост запаса углерода в древостое при 
изменении климата (сценарий FIR_C) по сравнению со стационарным немного меньше, 
чем в случае со сценарием без воздействий, поскольку увеличенная продуктивность 
древостоев частично нивелируется ростом потерь вследствие увеличения 
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интенсивности лесных пожаров. Однако увеличение продуктивности в случае 
климатических изменений превосходит потери углерода вследствие пожаров. 

Влияние пожаров на динамику запаса углерода в почве существенно менее 
значительно, чем их влияние на запас углерода в древостое, причем от них в большей 
степени страдает, что вполне предсказуемо, пул подстилки. Однако стоит заметить, что 
влияние изменений климата оказывает намного более существенное влияние на 
динамику запаса органического вещества в почве в целом и на относительную 
динамику различных его компонентов, чем пожары, которые в применяемых нами 
сценариях имеют небольшую силу и затрагивают относительно небольшие территории. 

Запас углерода в пуле сухостоя и валежа, после возрастания в начале периода 
моделирования, остается относительно постоянным на уровне около 11-12 т[C]/га, но с 
небольшими флуктуациями, вызванными двумя противоположными процессами. С 
одной стороны, данный пул постоянно пополняется за счет отмирания деревьев, 
поврежденных пожарами. С другой стороны, в процессе пожаров происходит 
частичное выгорание запасов сухостоя и валежа и, как следствие, дополнительная 
эмиссия в атмосферу углекислого газа. 

Следует отметить, что разные фракции органического вещества лесных почв 
разным образом реагируют на имитационные сценарии. Гумус, являясь буферным 
компонентом почвы с длительным временем жизни и низкими скоростями разложения, 
медленно реагирует на внешние воздействия и климатические изменения. Подстилка, 
будучи лабильной фракцией, довольно быстро реагирует на изменение внешних 
условий – ее количество может испытывать как сильные краткосрочные колебания, 
вызванные пожарами, так и долгопериодические колебания, связанные с изменением 
климатических показателей. 

Также следует отметить, что динамика запасов углерода в древостое более 
разнообразна, чем динамика запасов углерода в почве. Подобное разнообразие 
проявляется не только при сравнении разных имитационных и климатических 
сценариев, но и при анализе временно́й динамики для одного сценария, где имеют 
место значительные колебания данного показателя во времени. 

Выше рассматривалась динамика запасов углерода для изучаемой территории в 
целом. Однако можно предположить, что, в зависимости от эдафо-ценотических 
условий, эта динамика будет существенно различаться. С целью выявления данных 
различий результаты моделирования были сгруппированы по типам леса, выделенным 
в соответствии с эдафо-ценотическими рядами типов лесов по В.Н.Сукачеву (Желдак, 
Атрохин, 2002). Для анализа влияния изменений климата на динамику запасов углерода 
в разных типах леса были рассчитаны разности (в %) между начальным и конечным 
значением запаса углерода в почве и древостое (рис. 14). 
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Рис. 14. Изменение (в %) запасов углерода в пулах древостоя и почвы при изменениях 
климата для разных типов леса (заказники «Белый» и «Ляльский», сводные данные) 
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Рис. 15. Изменение (в %) запасов углерода в пулах подстилки и гумуса при изменениях 
климата для разных типов леса (заказники «Белый» и «Ляльский», сводные данные) 

 
Как видно, наибольшее влияние изменения климата оказывают на динамику 

пулов углерода в сухих местообитаниях с бедными почвами, а наименьшее – на 
местообитания с избыточным увлажнением и богатыми почвами, что особенно хорошо 
заметно на примере относительно стабильного пула углерода минеральной почвы (рис. 
15). 

Разные имитационные сценарии неодинаково влияют на сукцессионную 
динамику насаждений, что привело к различиям в видовом составе и возрастной 
структуре на конец периода моделирования. Так, в сценарии без воздействий к концу 
периода моделирования возрастают доли сосны для заказника «Белый» и ели для 
заказника «Ляльский». Насаждения имеют полночленный возрастной спектр, высока 
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доля спелых и перестойных древостоев. 
Имитационные эксперименты, проведенные для других территорий в той же 

растительной зоне (Chumachenko et al., 2003), показали схожую динамику видового 
состава древостоев, с доминированием конкурентных видов. Такие результаты хорошо 
согласуются с современными представлениями о долговременной динамике лесных 
экосистем (Чумаченко, Смирнова, 2009). 

Сценарии с лесными пожарами приводят к незначительному увеличению долей 
березы и сосны, которые являются основными участниками послепожарных сукцессий, 
при таком же незначительном снижении доли ели. Пожары также приводят к 
увеличению доли молодых и приспевающих деревьев за счет повышенной смертности 
старых. 

Прогнозы относительно влияния климата на динамику видового состава обычно 
говорят о возможном сдвиге растительных зон на север со скоростью 200-1000 м в год 
(Iverson, Prasad, 1998; Pearson, 2006; Johnston et al., 2009) вследствие миграции 
отдельных видов. Возможность сдвига растительных зон и замена хвойных и 
мелколиственных видов широколиственными отмечалась в ряде исследований, 
использующих как палеоэкологические методы (Overpeck et al., 1991), так и методы 
имитационного моделирования (Sykes et al., 1996; Iverson, Prasad, 1998, 2001). 

Также следует отметить, что климатические показатели не оказывают заметного 
влияния на видовой состав и возрастную структуру древостоев – динамика этих 
параметров практически полностью определяется имитационным сценарием, который 
«маскирует» эффекты изменений климата, однако некоторые различия между 
сценариями со стационарным климатом и с климатическими изменениями все же 
имеются, особенно в сценарии без воздействий. В частности, изменения климата 
приводят к относительному повышению доли мелколиственных видов и к небольшому 
снижению доли ели. Такие результаты вполне согласуются данными полевых 
наблюдений, приведенными выше. Однако здесь следует отметить, что в долгосрочной 
перспективе (моделирование на несколько сотен лет) следует ожидать, что эффект 
изменений климата выйдет на первое место. 

 
================================= 

Совокупность приведенных в этом разделе материалов по различному 
применению модели EFIMOD показывает перспективность использования методов 
математического моделирования для количественной оценки влияния антропогенных 
нарушений и изменения природной среды на лесные экосистемы, а также для 
экологической и хозяйственной оценки возможных вариантов и сочетаний режимов 
лесопользования. Это позволит в будущем использовать математическое 
моделирование для конкретных лесных массивов на достаточно больших территориях в 
дополнение к классическим инструментам прогнозирования в лесном хозяйстве. 
Модель EFIMOD уже была успешно апробировна на территории более 3 млн. га в 
Мантуровском лесничестве Косторомской области и Железнодорожном лесничестве 
Республики Коми (Шанин, 2011; Shanin et al., 2011). 
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ЗАКЛЮЧЕНИЕ 
В свое время автор первой законченной научной классификации типов леса и 

местообитаний России барон Артур фон Крюденер писал: «…и только тогда, когда 
лесоводы [в будущем] научатся с математической точностью учитывать 
производительные силы почво-грунта, только тогда померкнет звезда типов [леса]…» 
(Крюденер, 1916: стр. 16). Это время скоро наступит. Математические модели лесных 
экосистем и их компонентов (древостоев, почв, напочвенного покрова, и т.д.) 
постепенно, хотя еще медленно, становятся инструментом прогноза в 
лесохозяйственной и природоохранной деятельности в рамках реализации принципов 
устойчивого лесного хозяйства ближайшего будущего. Пока еще применеие моделей 
бывает затруднено как из-за пробелов в наших знаниях о функционировании лесных 
экосистем, так и из-за еще ограниченных возможностей вычислительной техники. 
Кроме того, в практическом лесоводстве еще не осознана перспективная роль 
математического моделирования. 

Данное методическое пособие описывает методы использования базовой модели 
лесной экосистемы EFIMOD для лесохозяйственных и природоохранных целей еще со 
значительной долей ручной обработки результатов моделирования. Однако, это дает 
возможность достаточно подробно описать все этапы работы. В настоящее время при 
таком моделировании уже созданы профессиональные программные надстройки 
(модули), позволяющие значительно ускорить и облегчить использование моделей для 
больших лесных массивов с десятками и сотнями тысяч выделов (Shanin et al., 2011). 

 
Данное пособие регулярно обновляется. Актуальная версия доступна в 

электронной форме по адресу http://ecomodelling.ru/images/stories/efimod_tutorial.pdf 
(сайт Лаборатории моделирования экосистем http://ecomodelling.ru/, раздел «Модели»). 
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